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Chapter 1

Getting Started

Introduction

What is BOSS?

Ballot Origination Software System (BOSS) is a software application that creates electronic ballot styles 
based on jurisdictional and election-specific information.  When BOSS generates electronic ballot styles, 
they are stored in a single data file that contains all information necessary to conduct the election at any 
polling place. Once the ballot is generated, the BOSS database is locked and no further changes can be 
made to the election data. This preserves the integrity of the data file.

After ballot generation, BOSS writes the election data file to PC card memory devices called Mobile 
Ballot Boxes (MBBs), which are transported to various polling places throughout the jurisdiction. MBBs 
can be used in any polling place because each MBB contains the same election data file.

MBBs are used to configure the Hart polling place components, which include the eScan paper ballot 
scanner, Judge’s Booth Controller (JBC) and eSlate voting units. In addition to supplying data required to 
display ballots, MBBs also store Cast Vote Records (CVRs) from each completed ballot. MBBs are also 
used to configure Ballot Now for paper ballot printing and processing.

The BOSS election database is also used to initialize a tabulation database in the Tally software 
application. Tally reads and tabulates CVRs from polling place MBBs and/or Ballot Now MBBs, so you 
can report election results. 

This Document
This Document is a training manual designed to guide operator training, and it is meant for use in 
conjunction with the BOSS Operations Manual. This training manual is intended for both initial training 
with Hart InterCivic training specialists and as a reference to supplement the operations manual once 
training is complete.

All steps that refer to a window, field, button, menu, or menu item on the display have the reference 
in bold (e.g., Save, Close, OK), unless referring to a table or list.
All steps that refer to a key on the keyboard have the key underlined (e.g., Ctrl, Shift, Enter).
The word “click” refers to a left click with the mouse unless otherwise stated.
All report titles are referred to in quotation marks, (e.g., “Ballot Content Proof”), unless referring to a 
table or list.

Refers to a cross-reference for more information regarding the topic.

Refers to a suggestion.

Refers to an advanced user tip.

Refers to a warning or caution.

Refers to steps that are unique to creating a primary election. These steps vary from 
those for creating a general or special election.

  See:
  See:

  Note:

  Tip(s):
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BOSS Operator Course Objectives

In the course associated with this document, you will:

Manually input data to create an election database in BOSS
Create an election database via importing data into BOSS
Use TRANS to record audio for DAU eSlate use
Proofread reports and ballot previews
Create ballot media
Practice secure database management
Finalize a BOSS database for Tally
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Hart Voting System Data Flowchart
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Hart Voting System Security Features
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BOSS Windows • About BOSS window 
showing the application 
version information

• If the Release number 
does not match your 
state-certified version, 
contact Hart InterCivic 
immediately.

• If the words “Not 
Certified” display, 
contact Hart InterCivic 
immediately. 
 

• Open Database 
window showing BOSS 
database list

• Database Description
• Database Filepath
• Database Status

• Available Actions

• Ballot Origination 
Software System 
window with title bar 
showing Database 
Description of selected 
database

• Active window and tab
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BOSS Menus

These menus are available in the BOSS menu bar. A brief explanation of each 
menu item follows:

File Menu

• Navigate to Open 
Database window

• Exit BOSS
• Identifies window 

currently open

Election Menu

Navigate to 
• Jurisdiction window
• Active Contests 

window
• Ballot Formats 

window
• Write Ballot Media 

window
• Import/Export window

Reports Menu

• Open variety of BOSS 
reports

• Arrow indicates that 
other detailed reports 
are available

Administration Menu

• Access Non-Election 
Tasks (Change 
Password and Users 
Maintenance)

• Finalize Election for 
Tally

Help Menu

• Access information 
about the BOSS 
application version
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Maximum Number of Characters for Fields in BOSS
The following table lists the maximum number of characters allowed in BOSS window data entry fields 
(organized alphabetically by window, then field). 

Window Name Field Name
Maximum 

Characters

Active Contests Ballot Instruction Title Text 1,000

Candidate Name 100

Wording for Proposition Choice 30

Custom Ballot Text 1,000

Ballot Instructions eSlate Instruction Text 2,000

eSlate Audio Prompt 2,000

Ballot Now Instruction Text 2,000

Change Password New Password Minimum: 6
Maximum: 12

Contest Details Contest Title 100

Contest Description 1,000

Number of Valid Choices 2 digits

Number of Write-Ins 2 digits, not to 
exceed 
number of 
valid choices

Create Database New Database Description 50

Details for Candidate Candidate Details 50 per row

eScan Options eScan Passwords 6 numbers

eSlate Options eSlate Passwords 6 numbers 
and/or 
UPPERCASE 
letters

Instruction Text Instruction Text 500

Jurisdiction - Contests tab Contest Title 100

Contest Description 1,000

Jurisdiction - Districts tab District Name 1,000

Jurisdiction - Jurisdiction tab Election Title 100

Ballot Header 100

Jurisdiction Title 50

Write-in Label 40

Precinct Label 32

Jurisdiction - Polling Places tab Polling Place Name 60

Polling Place Description 60

Jurisdiction - Precinct-Level Contests tab Contest Title 100

Contest Description 1,000
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Jurisdiction - Precincts tab Precinct Name 15 (precinct 
and split 
combined)

Split Name 15 (precinct 
and split 
combined)

Enter Registered Voter Totals by Party 7 digits

New User New User ID Minimum: 6
Maximum: 12

Password Minimum: 6
Maximum: 12

Party Maintenance Code 3

Party Name 50

Primary Ballot Header 100

Proposition Text Proposition Text 5,000

Window Name Field Name Maximum 
Characters
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Database Management

BOSS Database Management

BOSS database management includes naming the database with a convention that is user friendly; 
keeping track of the database status; proofreading and using BOSS reports; testing; noting the database 
file path for CD backup; and deleting and restoring databases. The BOSS Open Database window 
displays the Database Description, Database Filepath, and Database Status. The BOSS title bar 
displays the Database Description after you have selected an available database.

Database Naming Conventions (Database Description)

Use a consistent naming convention. There is a limit of 50 characters in the New Database Description 
field in BOSS. Suggested convention:

Description of the Database

Describe the function of this database. Databases may be set up for training purposes, voter education 
and outreach events, or live elections. The “Description of the Database” wording may be entered in ALL 
CAPS to help with database identification.

Sequence Number

Election databases are live databases that are used for ballot generating, proofing from ballots, writing 
media, performing logic and accuracy testing, and running live elections. The sequence number 
indicates the iteration of the database from the original database and how many times errors were 
detected and the database copied forward and corrected.

For example, you created a database called “ELECTION 1 Special 5.03.03.” The “ELECTION 1 Special 
5.03.06” database had errors, so you copy it forward to make corrections. “ELECTION 2 Special 
5.03.06” is the second iteration of the database. Delete the original database. Only one working 
ELECTION database should exist at a time.

Election Type and Date

Include the election type and the date of the official Election Day; for example, “General 11.08.05.”

Description of the Database Sequence Number Election Type and Date

TRAINING 1 Special 5.03.06

ELECTION 2 Special 5.03.06
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Database Status

Proofreading

Proofreading includes checking BOSS reports for errors in spelling and assignments as well as checking 
ballot proofs for errors. English content can be proofed from reports. After generating ballot previews, 
other languages can be proofed from the ballot preview printouts.

Proofreading the Reports

Testing

Logic and Accuracy testing (L&A, or LAT) is testing of the accuracy of the tabulation system compared to 
the input on the voting device. Logic and accuracy testing should take place before going live with an 
election, including Early and Absentee voting. Follow federal, state, and local guidelines for logic and 
accuracy testing. Refer to the Tally and Support Procedures documents for more information on logic 
and accuracy testing and functionality testing (testing of the hardware functionality). Logic and accuracy 
testing is done from the BOSS ELECTION database that will be used for the live election and the Tally 
TEST database.

Status Availability

Open In this state, users with the correct security permissions can enter and 
edit ballot data.

Ballot Generated In this state, the ballot has been generated and further changes to the 
database cannot be made. New data cannot be entered, and existing 
data cannot be edited. Users with the correct security permissions can 
write MBB and audio cards.

Finalized In this state, the election has been locked and is available for Tally 
processing. Changes to the database cannot be made. Media cards 
cannot be written.

Report Availability Proofreading Function

Active Contests Options List All db statuses Check all election data for spelling 
and correct candidate/option 
assignments to contests

Contest List with Details All db statuses Check contest-precinct assignments

Assigned Precinct (District 
Report)

All db statuses Check precinct-district assignments

Ballot Content Proof Available after ballot is 
generated

Check ballot content per style, 
including precincts assigned and 
contests, but not including contest 
options

Ballot Style List by Precinct Available after ballot is 
generated

Check precinct assignments to ballot 
styles

Ballot Style List by District Available after ballot is 
generated

Check district AND precinct 
assignments to ballot styles
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Database File Path 

The database file path records the directory for the 
BossData.db database file. All BOSS databases 
include this file name in a unique folder. Each 
folder is named with the Year, Month, Day – Hour, 
Minute, Second (24-hour clock) that the database 
was created. For example, database folder 
“050107-095451” was created on January 7, 2005 
at 9:54:51 a.m. The file path to each folder is also 
in BOSS in the Open Database window. Each 
numbered BOSS folder includes BossData.db, 
BossData.cfg, and BossData.log files. 

Backing Up a BOSS Database

Back up by navigating to the BOSS database folder and copying the entire numbered folder to CD, or by 
clicking Archive Database in the Open Database window. The archive function saves only the original 
BOSS database (BossData.db) and database configuration (BossData.cfg) files to a new location, not 
the entire numbered folder. 

Back up the numbered BOSS database folder (or click Archive Database in BOSS), and export all data:
• Immediately before exporting text for translation
• After importing translated text and audio
• After completing all proofreading and before generating the ballot
• After generating the ballot and writing media, but before finalizing the database
• After finalizing the database

  See:
  See:“Appendix D: Backing Up Election Databases” on page 113.

Deleting a BOSS Database

Delete BOSS databases that were used for practice or testing purposes. Delete databases that 
contained errors, after copying these databases forward to correct errors. Once an election is completed, 
and after an appropriate (federally or locally mandated) waiting period has passed, election databases 
may be deleted in order to save hard drive space on the PC. 

To delete a BOSS database, take note of the database file path in the Open Database window, and then 
click the Delete Database button to delete the database from the window. Next, exit BOSS, navigate to 
the numbered folder indicated in the database file path, and delete the numbered database folder.

Restoring a BOSS Database

A backed-up or archived BOSS database, with configuration file, can be restored into the BOSS 
database directory structure. This function is useful for bringing in a BOSS database created on a 
separate BOSS PC or for bringing in a backed-up BOSS database for use as a template for an election 
similar to a past election. This functionality can also provide emergency backup to a previous state of the 
database if the BOSS database is archived before generating and before finalizing, for example.

When the database is restored:

BOSS creates a new database folder named with current date and time for the restored database.
The restored database appears in the Open Database window’s list of available databases.
The restored database exists in the state it was in when archived (e.g., a finalized database will 
remain finalized).
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Establishing BOSS User Permissions

First Login After Installation of BOSS

The following steps must be completed at the first startup of BOSS after installation. If this has already 
been completed during installation and testing by Hart InterCivic, you should create local users and 
permissions and delete those users added during installation and testing.

1. Start BOSS from either the desktop shortcut or the 
Start button on the Windows taskbar. 

2. In the User ID field enter a User ID for an 
administrator who will have ALL authority in BOSS. 
Field limit is 6-12 letters or numbers, case 
sensitive.

3. In the Password and Confirm Password fields, 
enter the password for the Administrative User. 
Field limit is 6-12 letters or numbers, case 
sensitive. 

4. Click the OK button.

Creating Additional Users

1. Go to the Administration menu and click Non-
Election Tasks.

2. Click Yes to log off the current database.
3. Go to the Administration menu and click Users 

Maintenance.
4. Click the Add User button and enter a new User ID 

and Password.
5. Select the appropriate permission setting and click    

OK.

BOSS User Permissions

BOSS Function UPDATE VIEW ALL

Create Databases No No Yes

Change Current User Password Yes Yes Yes

Delete Databases No No Yes

Modify Databases Yes No Yes

Users Maintenance No No Yes

View and Print Election Reports Yes Yes Yes

View and Print Security Audit No No Yes
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Establishing Election Types and Organization Within BOSS
In BOSS, each ballot style is automatically created in the background as precincts and split precincts are 
assigned to districts, and then districts are assigned to contests. More ballot styles are created if ballot 
rotation is used. During a primary election, ballot styles may also be associated with each party and/or 
with cross-party voting in a modified closed primary. The number of ballot styles in an election is 
determined by the number of unique contest combinations available to voters. 

Once you generate the ballot in BOSS, you can view the ballot styles and their associated precincts in 
the Ballot Generation/Preview window unless ballot rotation is used. You can also view the “Ballot 
Content Proof”, “Ballot Style by District”, and “Ballot Style by Precinct” reports after generating. 

It is important to plan the organization of ballots in BOSS so that the content is correct, tabulation 
reporting is accurate, and the ballot layout is user-friendly.

General Information
A Split Precinct (“Split”) is the smallest political division in BOSS.
A Precinct is a grouping, usually associated with a geographic area, in a jurisdiction.
A District is a combination of precincts and/or splits.
There is no functional difference between an election identified as “Special” and one identified as 
“General” in BOSS.
When you select a state in the State Code field of the Jurisdiction tab, BOSS defines state-specific 
requirements such as the handling of candidate cross-filing.

  See:
  See:“Appendix A: State-Specific Behavior” in the BOSS Operations Manual for the election 

requirements of each state.

Party Maintenance
It is not necessary to associate a party name with a party code, unless that party is a straight party 
contest option.
In a general election, although registered voters are entered into BOSS by party, voter turnout results 
are calculated against the total number of voters (i.e., aggregate) in a split or precinct.

Party Maintenance Window for a General Election
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Party Maintenance Window for a Closed Primary Election

Party Code: The party code only helps you organize the election and does not appear on the ballot.
Party Name: The party name appears on eSlate and Ballot Now ballots below the candidate’s name.
Primary Ballot Header: This text appears on the first line of a primary ballot.
The “NP” party in BOSS is a default party code that cannot be deleted.
• The “NP” party in BOSS is always associated with a nonpartisan group of voters (party).
• In a nonpartisan election, all candidates are assigned to the “NP” party code, but no party name 

is assigned to that code, so only the candidate names appear on the ballot.
• You can overwrite the “NP” party code by highlighting the party code and typing in another 

nonpartisan-associated code.  Hart InterCivic recommends that you leave the “NP” party code in 
your database even if you are not using it to avoid complications when setting up a Modified 
Closed Primary Election.

• In a partisan General Election, you can ignore (recommended) or overwrite the “NP” party code, 
but you cannot delete it. 

• In a General Election with both partisan and nonpartisan contests, the “NP” party should be 
associated with nonpartisan candidates. Assigning a nonpartisan party name in association with 
the code is optional.

Primary Elections

In primary elections, use the Contest Description field in the Jurisdiction window to enter party 
information per contest, as contest names may be the same for each party. This is an organizational tool 
that will not appear on the ballot. Also, assign the Primary Party Affiliation field correctly in the Contest 
Details window. This is an organizational tool that will determine party associations, but will not appear 
on the ballot.

Closed Primaries

There are two types of closed primary elections that can be organized in BOSS:

A closed primary where each JBC is assigned to a specific party and only those ballot styles will be 
available. Polling places may be shared, but each JBC will be party-specific.
A closed primary where all parties share the JBCs, and the poll worker must choose the voter’s party. 
After choosing the voter’s precinct on the JBC, if applicable, the poll worker chooses the voter’s party 
affiliation. Parties will be listed in the same order as presented in the BOSS Party Maintenance 
window.
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Modified Closed Primary

In a modified closed primary, parties can choose to let a non-party-affiliated population vote on party-
specific contests as long as the “NP” code is associated with the nonpartisan population. For example, 
the nonpartisan population called “Decline to State” must be associated with the “NP” code in the Party 
Maintenance window. All parties share the JBCs, and the poll worker must choose the voter’s party.

After choosing the voter’s precinct on the JBC, if applicable, the poll worker chooses the voter’s party 
affiliation. Parties and nonpartisan combinations will be listed in the same order as presented in the 
BOSS Party Maintenance window. This is also the case if the “NP”-code-associated-party has been 
moved; however, the first nonpartisan combination will appear in position “N”, where “N” = the total 
number of political parties defined in the Party Maintenance window.

In modified closed primary elections, click the Include in Non-Partisan Ballots checkbox in the 
Contest Details window to make partisan contests available to nonpartisan voters.

Modified Open Primary

In a modified open primary (pick-a-party), the voter first chooses a party on his or her ballot, and then 
has only those associated contests available to vote because of associated dependencies. This election 
type is organized in BOSS as if it were a general or special election.

Cross-filed Candidates in Straight Party Contests

The state of Pennsylvania allows candidate cross-filing, meaning a candidate name can be used more 
than once in a contest when associated with different political parties.

In contests with cross-filed candidates that allow two or more choices, only one vote can be assigned to 
each cross-filed candidate. In Ballot Now, a contest with two votes for the same candidate must be 
resolved manually as an overvote. On the eSlate, a contest with two votes for the same candidate 
activates the Ballot Information screen, which warns that the voter has attempted to select a candidate 
whose cross-file alternative has been previously selected.

Ballot Formatting
Column and page forces can be achieved separately for Ballot Now and eSlate ballot formats in the 
Contest Details window. It is important to proofread the ballot style previews in order to best 
determine where to use column and page forces.
Including Ballot Text can be an effective tool to help voters navigate the ballot.
Using forced returns can be an effective tool to help voters navigate the ballot.

  See:
  See:“Appendix C: Hart Voting System Software User Tips” on page 109 for more information on 

forced returns.

Ballot Images

If required by state and local regulations, images can be added to contests and ballot text in BOSS. 
Image-enabled templates must be available in BOSS in order for images to appear on the ballots. To 
obtain these templates, contact Hart InterCivic.

Images that appear on a ballot are associated with ballot elements entered in BOSS. For example, 
adding an image to a proposition contest in BOSS will display that image in the title of that proposition 
contest. The ballot elements that may be associated with images and their positions are shown on the 
following page. Images cannot be associated with candidates.
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Image Requirements

BOSS only loads image files in bitmap (.bmp) format. The bitmap image colors are converted to a 
predefined palette. The images are not scaled when placed on the ballot. The size of the image when it 
is loaded into BOSS will determine the size on the ballot.

Image Palette

The images displayed on the eSlate use the standard Windows color palette of 256 colors. BOSS will 
convert images for eSlate to this color palette if necessary, but Hart recommends using an external 
image editing application. Images for paper ballots use a grayscale palette of 256 colors. BOSS will 
convert images for paper ballots to this palette.

Location Ballot Element Explanation

A Ballot Header Party image for primary ballots. 
OR NP Party image for non-primary elections.

B Straight Party Title Appears in the straight party title

C Straight Party Option Image associated with party

D Straight Party Option Image associated with party

E Ballot Text Appears below the ballot text

F Proposition Title Appears in the proposition title

G Candidate Title Appears in the candidate title

H Ballot Instruction Appears below the ballot instruction text
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Image Size

Image size is determined by the size of the image loaded in BOSS. The image is not scaled for display 
on the ballot. The resolution of the eSlate images should be 72 dots per inch. The resolution of the image 
for paper ballots should be 254 dots per inch. BOSS does not enforce the resolution, but failure to follow 
these recommendations may result in ballot graphics that are larger or smaller than expected.

The position of the image is determined by the template selected for ballot generation. Use the table of 
recommended image sizes below to scale images before loading into BOSS. If the images are larger 
than the recommended size, they may overlap other ballot elements. Images are arranged in the center 
of the available space if they are smaller than the recommend size.

The following table provides recommended image sizes in pixels. After loading ballot images, view the 
images in the BOSS ballot preview window. If changes are necessary, resize the images outside of 
BOSS and reload them.

Transparency

All eSlate images are assumed to be transparent. The pixel in the upper left corner of the image is used 
to determine the transparent color. All pixels in the image that have the transparent color will be 
displayed as the background color. The preview does not show the transparency. Paper ballots do not 
use transparency. All pixels from the paper ballot images are displayed.

Loading Images in BOSS

To load an image from the Party Maintenance or Contest Details window: 

1. Select the party or contest for which you want to associate an image.
2. Click the Add Image button. 
3. Choose the language of the ballot and the device (eSlate or paper) where the ballot will appear.
4. Click the Browse button, navigate to the image, select the image, and click Open.
5. Click the Load button and click Close. 

  Note:
To load an image in the Ballot Header, contact Hart Intercivic for the appropriate template.

  See:
  See:The BOSS Operations Manual for information about image placement on primary ballots and for 

more information about adding images to ballots.

Location Ballot Element Image Size for eSlate Image Size for Paper Ballot

A Ballot Header 100 W x 100 H 200 W x 200 H

B Straight Party Title 250 W 600 W, 400 W

C Straight Party Option 20 W x 20 H 50 W x 50 H

D Straight Party Option 20 W x 20 H 50 W x 50 H

E Ballot Text 250 W 600 W

F Proposition Title 250 W 600 W

G Candidate Title 250 W 600 W

H Ballot Instruction 250 W 600 W
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Translating Foreign Language Ballot Text

The windows in BOSS allow for data entry in English only. If the target election requires ballots in other 
languages, you must use TRANS to add foreign language translations and to record audio associated 
with that text. TRANS is the Hart Voting System utility for translation, recording, and audio normalization.

Follow these steps in order to translate ballot text:

1. The foreign language must be selected in the Select Language Details window in order for any 
language other than English to appear on ballots.

2. Complete the English language ballot either in BOSS or via ASCII data imports on the Import tab 
of the Import/Export window.

3. Proofread the reports and ballot preview screens in BOSS.
4. Go to the Election menu and click Import/Export.
5. Click the Translation and Recording Export/Import tab.
6. Export English text for translation in TRANS.
7. Import the completed foreign language translated text. 

> Foreign language text will not appear in the BOSS GUI, but it will appear in ballot previews.
8. If necessary, make corrections in English, then repeat the export/import foreign language 

process to correct the foreign language for the changed text strings and audio prompts.
9. Continue to complete audio recording using the TRANS application.

Do not import foreign language text in ASCII data files. Do not import any text in Unicode fonts.

After exporting text for translation, do not make BOSS database changes until completed text 
translations have been imported.
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Recording Audio

Audio for the Disabled Access Unit (DAU) user can be recorded only in the TRANS software utility. 
TRANS is the Hart Voting System utility for translation, recording, and audio normalization.

Follow these steps to record ballot audio:

After exporting prompts for audio recording, do not make BOSS database changes until completed 
audio has been imported.

1. Complete and proof all ballot data.
2. To include foreign languages, complete foreign language text export-translate-import process.
3. Go to the Election menu and click Import/Export.
4. Click the Translation and Recording Export/Import tab.
5. Export English language prompts for recording in TRANS.

> English audio may be completed while foreign language text is being translated, as long as 
the original English ballot text is not changed.

6. Export foreign language prompts for recording in TRANS.
7. Import English and foreign language manifest (.xml) files.

> For each language there is a manifest file that serves as an index to the associated audio.
8. Select ballot templates, complete the final proofing process, and create ballot media.
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Audio Recording Best Practices
Before recording, always check and adjust PC master volume controls and microphone properties 
for best sound volume and quality.

Record audio in a location that has limited background noise.
Set up the recording station with the following, or similar, equipment in order to reduce noise while 
recording:
• Handheld dynamic microphone and cable
• Microphone tabletop stand
• XLR female to 1/4 inch male stereo microphone input transformer
• 1/4 inch to 1/8 inch stereo plug adapter (to computer mic port).
After recording, check audio quality by creating a sample ballot for use in a Demonstration eSlate.

TRANS 2.1 Audio Window with Spanish Audio Recorded

  See:
  See: The TRANS User Guide for detailed information.
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Planning for eScan Use
eScan is the Hart Voting System precinct digital scanning device. eScan ballot content is set up in 
BOSS, and ballots are printed from Ballot Now. eScan can read ballots for:

Absentee voting for all precincts in the election
Early Voting in-person at a polling place with one or multiple precincts assigned
Election Day voting in-person at a polling place with one or multiple precincts assigned.

If using the eScan, there are several factors to consider in BOSS:

1. eScan passwords MUST be defined in the eScan Options window, accessible through the 
Jurisdiction tab of the Jurisdiction window.

Although eScan cannot be operated without passwords, it is possible to generate the ballot in 
BOSS without defining eScan passwords. Always remember to define eScan passwords! 

2. Before the ballot is accepted, eScan Ballot Processing 
permissions MUST be established in BOSS via the 
eScan Options window. The Ballot Processing 
permissions panel allows the BOSS user to determine 
who is authorized to place various types of mismarked 
eScan ballots (e.g., undervoted, overvoted, and blank 
ballots) into the eScan ballot box – the voter or the poll 
worker. Alternatively, eScan can be set to “Always 
Accept” undervoted, overvoted, or blank ballots. See 
the figure at right for the default settings. 
> If the Always Accept option is selected for a 

particular type of mismark (e.g., overvote, 
undervote, or blank), and the ballot contains that 
type of mismark only, the ballot will immediately be 
accepted as-is, with no further notification message.

> If the voter is authorized to accept a particular type 
of mismark (Voter Accepts), and the ballot contains 
that type of mismark only, eScan will display a 
notification message. Without further assistance 
from a poll worker, the voter may ignore the 
mismark and cast the ballot as-is.

> If the poll worker is authorized to accept a 
particular type of mismark (Poll Worker Accepts), 
and the ballot contains that type of mismark only, 
eScan will display a notification message. To ignore the mismark and cast the ballot as-is, the 
voter must contact a poll worker for assistance.

> If the ballot contains a mix of various mismarks (e.g., both undervotes and overvotes), and 
there is a mix of ballot processing permissions in place, the following rules apply:
__Poll worker assistance is required to cast the ballot if the ballot contains any type of 

mismark for which poll worker authorization is required, regardless of other voter 
permissions that may exist.

__The voter may cast his or her ballot without further assistance if the ballot contains no 
mismarks that require poll worker authorization. However, if the ballot contains any type of 
mismark that requires voter authorization, eScan displays a notification message before 
the ballot can be cast, regardless of other types of mismarks on the ballot that may be set 
to Always Accept.

Ballot Processing Default Settings



BOSS Training Manual 6300-002 62C

Page 22 Chapter 1   Getting Started © Hart InterCivic, Inc.

  See:
  See:The BOSS Operations Manual for all possible ballot processing settings.

3. Ballot Now/Paper Ballot settings in BOSS apply to ALL paper ballots. Keep this in mind when:
> Writing Ballot Now instructions 

__To write instructions, go to the Election menu and click Jurisdiction. On the Jurisdiction 
tab, click the Ballot Instruction Texts button and select Ballot Now Instruction Text in 
the window that appears.

> Selecting paper ballot templates 
__To select templates, go to the Election menu and click Ballot Formats. In the Ballot 

Generation/Preview window, click the Ballot Templates tab. 

4. In order to set up the eScan for Absentee voting, you must enter the Absentee location Polling 
Place ID into the eScan during device configuration. This ID is not available from BOSS reports. 

Find the ABSENTEE Polling Place Description on the Polling Places tab of the Jurisdiction 
window after the ballot has been generated with paper ballot templates selected.

  Tip(s):
The Ballot Now Polling Place Name is automatically created when any paper ballot template is 
used to generate the ballots.

  Note:
You can use Tally to read and tabulate write-in images from the eScan, so you may not need to 
hand-sort eScan ballots with write-ins. However, Tally can only recognize the write-in image 
when the Write-In option box on a paper ballot is marked correctly. Follow federal, state, and 
local guidelines for tabulating write-ins.

  See:
  See:The Tally Training Manual for information about working with write-in images in Tally.
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Planning for Demonstration eSlate Use

What is the Demonstration eSlate?

The Demonstration eSlate, also known as a “demo unit,” allows voters to practice using the eSlate 
buttons and interface (including headphones and adaptive devices, if desired) on a functioning unit that 
cannot record votes. The demo unit does not require a JBC in order to display ballots because it uses a 
special ATA memory card that contains both ballot and audio data.

Creating a Demonstration eSlate Ballot in BOSS

When creating a ballot to display on the demo unit, ensure the following:

The VBO Required checkbox in the eSlate Settings window is selected if the demo unit will be 
connected to a VBO unit. If this checkbox is selected and a VBO unit is not connected, the eSlate 
functions as if a VBO unit is present.
The first precinct in the Polling Places tab of the Jurisdiction window is associated with a polling 
place. The demo unit displays only the ballot style for the first precinct listed.
For Primary Elections, the first party listed in the Party Maintenance window is the party whose 
ballot you want to display on the demo unit. The demo unit displays only the ballot style for the first 
party listed.
All English audio has been recorded.
All multi-language text has been translated and audio has been recorded, if applicable.

Once you have ensured that your demonstration ballot is correct, generate ballots using a template for 
the eSlate and write a demo card for each demo unit. Hart recommends that you create demo cards 
from a demonstration election that contains fictional, sports/famous, or historical names for candidates. 
You should not create demo cards from a live election database.

  Note:
Although your eCM token and password are required to generate a ballot to use with the demo 
unit, you do not need to program your signing key to the demo unit in SERVO, nor must you reset 
the demo unit between uses.

  See:
  See:The Demonstration eSlate Preparation Guide for more information including setting up and using 

the demo unit.
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Planning Ballot Media Quantities

Ballot Media to Write Per Election

Once the ballot is generated, copy the election data to MBBs and audio cards by going to the Election 
menu and clicking Write Ballot Media. Use the MBB Worksheet (MBB_41406.xls) on your Hart CD or 
the following guide when planning the number of MBBs and audio cards to write for an election.

Ballot Media to Write Per Election

Test Mode MBBs Election Mode MBBs

• 1 MBB for each JBC included in LAT • 1 MBB for each JBC included in Early Voting in person

• 1 MBB for each eScan included in LAT • 1 MBB for each JBC included in Election Day voting

• 1 MBB for each Ballot Now PC included in LAT • 1 MBB for each eScan included in Absentee Voting (by 
mail)

• 1 MBB for warehouse testing (optional) • 1 MBB for each eScan included in Early Voting in person

• 1 MBB for each voting system in use at the Help Desk • 1 MBB for each eScan included in Election Day voting

Audio Cards
• 1 MBB per election source (i.e., Absentee, Early Voting, 

Election Day) for each Ballot Now (Server) PC used for 
voting

• 1 Audio Card per DAU eSlate included in the election 
(Early Voting and Election Day)

• 1 MBB per election source for incremental Cast Vote 
Record (CVR) processing (e.g., late mail) for each Ballot 
Now (Server) PC utilized for voting

• 1 Audio Card for warehouse testing (optional) • 1 MBB to enable SERVO to add election Event(s) for 
backup (This MBB can be reused as one of the JBC or 
eSlate recount MBBs)

• 1 Audio Card for the DAU eSlate in use at the Help Desk • 1 MBB (128 MB) per 65,000 CVRs for JBC CVR recount 
MBBs, using SERVO, for Early Voting in person

• 10% of total as spare Audio Cards
• Hart InterCivic recommends writing at least 10% above the 

number actually needed in the field as spare Audio Cards.

• 1 MBB (128 MB) per 65,000 CVRs for JBC CVR recount 
MBBs, using SERVO, for Election Day in person

Other Ballot Media • 1 MBB (128 MB) per 65,000 CVRs for eSlate CVR recount 
MBBs, using SERVO, for Early Voting in person

• Demonstration eSlate (Demo cards) with data similar to the 
live election for Voter Education and Outreach activities.

• 1 MBB (128 MB) per 65,000 CVRs for eSlate CVR recount 
MBBs, using SERVO, for Election Day in person

• Training MBB and Audio Cards with data similar to the live 
election for poll worker training activities.

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Absentee (by mail)

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Early Voting in person

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Election Day in person

• 10% of total as spare Election Mode MBBs
• Hart InterCivic recommends writing at least 10% above the 

number actually needed for the JBC, eScan, and/or Ballot 
Now units included in Absentee, Early, or Election Day 
voting. 
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MBB Capacity

Include the MBB Cast Vote Record (CVR) capacity when planning the number of MBBs required for an 
election.

128 Megabyte ATA Format MBB Capacities:

eSlate Subsystem CVR Capacity of One MBBa

a. All values are conservative estimates based on small CVR log size and multi-page ballots.

JBC 10,000 (Access Code range of 0000-9999)

Ballot Now 65,000

eScan 20,000

SERVO 65,000
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BOSS Tasks Requiring the eSlate Cryptographic Module (eCM)

What is the eCM?

The eCM is a physical USB security device provided by Hart InterCivic. It is required for access to 
secure functions in the BOSS, Ballot Now, Tally, Rally, and SERVO applications. The eCM must be 
generated using the eCM Manager application.

When is the eSlate Cryptographic Module Used?

In a given election, the signing key on the eCM is used by the BOSS application to accept the ballot 
formats for the election, and a matching signing key must also be present in the eCM(s) used in the 
Ballot Now, Tally, Rally, and SERVO applications. 

The simplest way to use an eCM is to keep the device handy (e.g., on a lanyard on your person) and to 
insert the eCM token into a USB port on an election PC each time that PC is being used, removing the 
eCM when finished.

When the eCM is accessed, Ballot Now requires the operator to enter the eCM PIN (a password 
selected by a jurisdiction administrator before any signing keys are generated).

In BOSS, the eCM is used to accept generated ballot format(s).

eCM Management

The eCMs should be closely managed. The number of eCMs being used for an election and their PIN(s) 
should be logged in a secure location. eCMs should be labeled with the election name or similar 
information, but not with the eCM Key ID or PIN. eCMs should be stored in a secure location, separate 
from election MBBs.
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Notes:
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Notes:
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Chapter 2

Creating a General or Special Election

Follow the steps outlined in this chapter in order to create a General or Special election.

Steps: Details:

1. Double-click the BOSS desktop shortcut 
to open the application.

OR Go to Start/Programs/Hart InterCivic/BOSS

2. Log in to BOSS as a user with all 
permissions.

3. If you haven’t already done so, set up 
BOSS users and permission levels.

Go to the Administration menu and click 
Non-Election Tasks. Click Yes.
Go to the Administration menu and click 
Users Maintenance.

  See:
  See:“Establishing BOSS User Permissions” on 

page 12.
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4. Create a BOSS database named 
“<Description # Election Type date>”.

Go to the File menu and click Open 
Database. In the Open Database window, 

click the  button.
In the Create Database window that appears, 
select a database to copy from, and complete 
the New Database Description field with a 
description of the database, the sequence 
number, the election name, and the date.
To create a blank database, copy the 
database from “(New Database)”.
Click OK.

  See:
  See:Suggested naming conventions in 

“Database Management” on page 9.

5. Open the new BOSS database. In the Open Database window, double-click the 
target database.

6. Define the general or special election 
jurisdiction information.

When you open a database, the Jurisdiction 
tab in the Jurisdiction window appears.
Defining Jurisdiction information includes:
• Election Title for the header of the ballot
• Election Type (does not appear on the 

ballot)
• Election Date for the header of the ballot
• Ballot Header for the 1st line of the ballot
• State Code (does not appear on the 

ballot)
• Jurisdiction Organization

  Tip(s):
Select the “Jurisdiction Organization” 
which best meets tabulation reporting 
needs AND maintains efficiency while 
setting up the BOSS database.

• Jurisdiction Title for the header of the 
ballot

• Use of the Incumbent Indicator on reports
• Write-in label to appear on the ballot
• Precinct label to appear on the ballot

Steps: Details:
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7. Define political parties. Click the  button.
Code is a required field. It will not appear on 
ballots. It is for organizational purposes.
Party Name is not a required field. Text 
entered in this field will appear on the ballot in 
association with candidates assigned to the 
party code.
• For a nonpartisan election where no party 

is to appear on the ballot in association 
with a candidate name, do not assign a 
Party Name in association with the “NP” 
Code. This is the default setting.

Click OK to save data and close the window.

8. Select the languages to appear on ballots. Choose the  button.
Select checkboxes to create ballots in 
languages other than English.
• Selected languages will have files for 

translation available for export on the 
Translation and Recording Export/
Import tab of the Import/Export window.

Select the Reuse English Candidate Name 
in every language checkbox in order to use 
only the English version of candidate names, 
and to withhold this data from exports for 
translation (i.e., no transliteration).
Select the Reuse English Candidate Details 
in every language checkbox in order to use 
only the English version of candidate details.
This data is not included in import files.
Click OK to save data and close the window.

  See:
  See:“Translating Foreign Language Ballot 

Text” on page 18.

9. Complete ballot instructions. Click the  button.
Ballot instructions include:
• eSlate instructions to appear at the top of 

the DRE ballot.
• eSlate audio instructions associated with 

the text for the top of the DRE ballot. 
• Ballot Now instructions to appear at the 

top of the Ballot Now and eScan paper 
ballots.

You can copy ballot instructions from a .txt file 
and paste them into BOSS fields. Use an 
ASCII font such as Arial or Times New 
Roman. Do not use Unicode fonts.
Click OK to save data and close the window.

Steps: Details:
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10.  Define eSlate options. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the Judge’s Booth 

Controller (JBC) operator a warning if s/he 
attempts to close or suspend the polls 
early, but it does not prevent such action.

• This data is not included in import files.
Early Voting suspend times should reflect 
the latest possible site suspend time.

Define the number of minutes the Access 
Code will be active after printing. (Required)
• 30 minutes is the default setting.
Select the Retrievable Early Voting Ballots 
checkbox in accordance with applicable 
election codes.
• This associates a Ballot Code with all 

early voting ballots, making these ballots 
available for exclusion from tabulation.

• This data is not included in import files.
Select a Summary/Verification font size.
Select the Allow Tally and Allow Write-In 
Report Print checkboxes in order to allow the 
JBC operator to print tabulation and write-in 
reports after closing polls on Election Day.  
The Allow Tally box is checked by default.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select the VBO Required checkbox in 
accordance with applicable election codes.
Select the number of times a ballot printout 
can be rejected in the VBO Ballot Rejection 
Limit field. The printout can be rejected a 
maximum of five times.
Select the Print Ballot Key checkbox in 
accordance with applicable election codes.  
The box is checked by default.
Enter eSlate Passwords. (Required)
• eSlate passwords must be uppercase 

and/or numeric, six (6) characters.
• This data is not included in import files.

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Click OK to save data and close the window.

Steps: Details:
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11. Define eScan options, if applicable. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the eScan operator a 

warning if s/he attempts to close or 
suspend the polls early, but it does not 
prevent such action.

• This data is not included in import files. 

Early Voting suspend times should reflect 
the latest possible site suspend time.

Enter eScan Passwords. (Required)
• eScan passwords must be numeric, six 

(6) characters.
• This data is not included in import files. 

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Select the Allow Tally Report Print 
checkbox to print the eScan tally tape.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select Ballot Processing permissions. 

Review ballot processing permission 
selections with elections officials. These 
settings determine who is allowed override 
permissions on the eScan device.

  See:
  See:“Planning for eScan Use” on page 21.

Click OK to save data and close the window.

12. Save Jurisdiction tab data. Click Save to save changes before exiting 
any window or tab in BOSS.
• You are prompted to save if you make 

changes and try to exit the window or tab.

Steps: Details:
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13. Define precincts. In the Jurisdiction window, click the 
Precincts tab to define precincts, splits, and 
the number of registered voters per party, per 
precinct/split.
• The number of registered voters must be 

entered by party.
• The Voters field will display the aggregate 

total for all parties per precinct or split.
• Arrow buttons move the selected row.

14. Define districts and assign precincts, if 
applicable.

In the Jurisdiction window, click the 
Districts tab to define districts and assign 
precincts to districts.
• Precincts and splits can be assigned to 

multiple districts.
• Arrow buttons add or remove precincts. 

15. Define contests. In the Jurisdiction window, click the 
Contests tab to define contests and Ballot 
Text, and to assign districts or precincts to 
contests.
• Use the Contest Description field as an 

organizational tool. 
• The Contest Details window is available 

for each contest by double-clicking on the 
target contest.

• Arrow buttons add or remove districts.

Steps: Details:
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16. Define precinct-level contests, if 
applicable.

In the Jurisdiction window, click the  
Precinct-Level Contests tab to define 
contests and Ballot Text and assign precincts 
to contests.

  Tip(s):
Precinct-Level contests in an election 
organized by districts can be included as 
single-precinct districts.

17. Define polling places. In the Jurisdiction window, click the Polling 
Places tab to define polling places and assign 
precincts to polling places.
• Election Day precincts assigned are 

removed from the list of Available 
Precincts

• Early Voting precincts may be assigned to 
multiple polling places

• Arrow buttons add or remove precincts. 

18. Select ballot rotation type. In the Jurisdiction window, click the 
Rotation tab to define rotation type. 
• No Rotation is an available option.
• A rotation index of “0” equals ballot order 

as presented in the Active Contests 
window.

• In California databases, the  button 

appears.

  See:
  See:The BOSS Operations Manual for more 

information about ballot rotation.

Steps: Details:
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19. Add contest details in the Active 
Contests window.

Go to the Election menu and click Active 
Contests.
Actions available in the Active Contests 
window include:
• Changing contest sequence with the 

arrow buttons
• Adding options (e.g., candidates)
• Associating parties with candidates
• Adding candidate details (e.g., delegates, 

occupations)
• Changing option sequence with the arrow 

buttons

20. Edit active contests in the Contest 
Details window. Click the  button or 

double-click a contest to open the Contest 
Details window (also available from the 
Jurisdiction window, Contests tab).
Actions available in the Contest Details 
window include:
• Identifying contest type (straight party, 

office, proposition)
• Enabling Rotation (checked and grayed 

when No Rotation is selected on the 
Rotation tab)

• Including the contest in straight party
• Identifying cumulative contests
• Identifying fractional cumulative contests
• Identifying common contests (leave 

unchecked unless otherwise directed)
• Identifying the number of valid choices 

and write-ins
• Adding contest-level instructions
• Adding Proposition Text
• Defining dependencies
• Forcing contest position
• Adding images to the ballot

  Note:
Force data is not imported.

Ballot Now contest position forces apply 
to all paper ballots (eScan and Ballot 
Now).

  See:
  See:“Ballot Images” on page 15.

The BOSS Operations Manual for more 
information about adding images.

Steps: Details:
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21. Proofread the available ballot reports, and 
make corrections if necessary.

Before generating, go to the Reports menu 
and click the following menu items:
• Active Contests to view the “Active 

Contests Options List” report
• Contest List to view the “Contest List 

with Details” report
• District Reports, Precinct Assignments 

to view the “Assigned Precinct Report”.

  Note:
“Ballot Content Proof” and ballot style 
reports are not available until after 
generating and accepting the ballot.

22. As a risk-reduction measure, back up 
BOSS data and the database.

22.1  Export all BOSS data files.

Go to the Election Menu, click Import/
Export, and then click the Export tab.
• Create an election folder with the date 

and time.
• Highlight (ALL) in the Select Element 

and Path/File to Export panel.

• Click the  button and navigate to the 
folder you created.

• Click the  button and 
respond to the dialog boxes that appear.

• Save export files to CD.
• Repeat this process after database 

changes.

  Note:
Page layout and password data are not 
exported.

22.2  Archive the database and save to CD. Go to the File menu and click Open 
Database.
• Create an election folder with the date 

and time.
• Highlight the target database.

• Click the  button.
• Follow prompts to navigate to the folder 

you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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23. (Optional) Prepare for ballot translation by 
proofreading the existing ballots.

Go to the Election menu and click Ballot 
Formats. Click the Ballot Templates tab, 
choose one or more templates, and click the 
Generate Preview button. On the Ballot 
Preview tab, proofread each ballot style and 
click Reject when exiting the window.

24. Create four folders on the PC Desktop for 
data import and export.

Hart recommends that you give the folders 
the following names:
• Export Text
• Import Text
• Export Audio
• Import Audio

25. Export text for multi-language ballot 
translation, if applicable. If your ballot is in 
English only, proceed to step 30.

Go to the Election menu, click Import/
Export, and then click the Translation and 
Recording Export/Import tab.
Navigate to the Export Text folder and click 

the  button.

  See:
  See:The BOSS Operations Manual for 

detailed information about foreign 
language import/export.

26. Move the contents of the Export Text 
folder into the Jobs folder.

  Note:
You must move files for translation into 
the Jobs folder in order for TRANS to 
recognize them.

27. Use TRANS to translate text for multi-
language ballots.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

28. Move the text files (.xlf) from the Jobs 
folder to the Import Text folder. 

  Note:
You must move the translated files from 
the Jobs folder in order to use them in 
BOSS.

Steps: Details:
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29. Import translated text for multi-language 
ballots.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Import Text folder and click 

the  button.

30. Export English text for recording in 
TRANS.

On the Translation and Recording Export/
Import tab of the Import/Export window, 
navigate to Export Audio folder and click the 

 button.
English audio prompts can be exported, 
recorded, and imported at any time after 
completing data entry and before generating 
the ballot.
English audio can be recorded while foreign 
language text is being translated.

  See:
  See:“Recording Audio” on page 19.

31. Export audio prompts for multi-language 
audio recording in TRANS, if applicable.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Export Audio folder and click 

the  button.

  See:
  See:“Translating Foreign Language Ballot 

Text” on page 18.

32. Move the contents of the Export Audio 
folder into the Jobs folder.

  Note:
You must move files for recording into the 
Jobs folder in order for TRANS to 
recognize them.

33. Use TRANS to record English and, if 
applicable, multi-language audio.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

34. Move the recorded audio files (.xml and 
.wav) to the Import Audio folder. 

  Note:
You must move the recorded files from the 
Jobs folder in order to use them in BOSS.

Steps: Details:
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35. Import recorded audio files. On the Translation and Recording Import/
Export tab of the Import/Export window:
• Click the “Enter import path for all audio 

files” radio button to import multiple audio 
files for a multi-language ballot.

• Click the “Enter import filepath name for 
one audio file” radio button to import one 
audio file for an English-only ballot.

Navigate to the Audio Import folder and click 

the  button.

36. Verify that the ballot is complete. Go to the Election menu and click Ballot 
Formats.
View the Ballot Data Validation tab to verify 
that the ballot is complete.
• A green circle indicates that the 

information is complete.
• A yellow triangle indicates that information 

is incomplete, but you can still generate 
the ballot.

• A red square indicates that the 
information is incomplete and you cannot 
generate the ballot until you supply the 
missing information.

37. As a risk-reduction measure, back up 
BOSS data and the database.

37.1  Export all BOSS data files.

Create an election folder with the date, time, 
and contents (in this case, BOSS data files).
Go to the Election Menu, click Import/
Export, and then click the Export tab.
• Highlight (ALL) in the Select Element 

and Path/File to Export panel.

• Click the  button and navigate to the 
folder you created.

• Click the  button and 
respond to the dialog boxes that appear.

• Save the export files to CD.
• Repeat this process after the database 

changes.

Steps: Details:
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37.2  Export all translated text and recorded 
audio.

Create an election folder with the date, time, 
and contents (in this case, translated text and 
audio).
After completing translations and audio, 
export ALL foreign language text and ALL 
audio from the Translation and Recording 
Export/Import tab.
• Navigate to the folder you created and 

click the  
button.
Deselect the 
checkbox.

• Navigate to the folder you created and 

click the  
button.

• Save the export files to CD.
• Repeat this process after the database 

changes.

37.3  Archive the database and save to CD. Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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38. Select templates and preview ballots. Go to the Election menu and click Ballot 
Formats.
Click the Ballot Templates tab and choose 
templates and paper size.
• Select paper ballot (Ballot Now/eScan) 

and eSlate DRE ballots in all formats and 
languages needed.

• If images have been added to the ballots, 
choose image-enabled templates. To 
obtain these templates, contact Hart 
InterCivic.

• Take written note of template(s) selected.
If choosing paper ballot templates for use 
with the eScan, you must create passwords 
in the eScan Options window. Although 
eScan cannot be operated without 
passwords, it is possible to generate the 
ballot in BOSS without defining eScan 
passwords.
The eScan device does not accept 11x17 
ballots.

• Click the  button.

39. Proofread the ballot on the Ballot 
Preview tab.

Click the Print Preview Image button to print 
the ballot currently in the window.
Click the Print Ballots button to print different 
ballot styles.
Print ballot previews in order to proofread all 
formats, ballot styles, and languages, before 
accepting ballot generation.
Determine the maximum length of any ballot, 
and consider revising format to reduce length 
(e.g., to keep paper ballots to one sheet).

  Tip(s):
Right-click the ballot image and choose 
Save Picture As... in order to save the 
ballot page as a “*.bmp” graphic file (for 
use in sample ballot flyers, for example).

Steps: Details:
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40. Generate the ballot, or go back to make 
corrections.

Once you accept the ballot, you cannot 
enter new data in this BOSS database.

To accept ballot generation, click the 

 button on the 
Ballot Preview tab.
• Confirm ballot acceptance in the dialog 

box that appears.
To reject ballot generation, close the Ballot 
Generation /Preview window and click 
Reject.

41. If you haven’t already done so, insert the 
eCM into a USB port and complete 
acceptance of ballot generation.

Before accepting ballot generation, the BOSS 
application prompts you to enter the eCM 
PIN.

The eCM can be removed from the USB port 
after the ballot has been accepted.
Store the eCM in a secure location.
The simplest way to use an eCM is to keep 
the device handy (e.g., on a lanyard on your 
person) and to insert the eCM into a USB port 
on an election PC each time that PC is being 
used, removing the eCM when finished

Steps: Details:
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42. Print Ballot Style reports. Go to the Reports menu and click the 
following menu items:
• Ballot Content Proof to view and print a 

report detailing precincts, contests, and 
registered voters per ballot style

• Ballot Syle Reports, and then Ballot 
Styles by District to view and print a 
report detailing all ballot styles and 
associated districts and precincts

• Ballot Syle Reports, and then Ballot 
Styles by Precinct to view and print a 
report detailing all ballot styles and 
assigned precincts (for election organized 
by precinct-contest associations)

43. Create the Mobile Ballot Boxes (MBBs) 
for use in the JBCs, eScan devices, Ballot 
Now PCs, and SERVO, Audio cards for 
DAU eSlates, and/or Demo cards for 
eSlate Demonstration units.

Go to the Election menu and click Write 
Ballot Media.

Decide the number of cards needed for 
the election, including recovery and 
SERVO MBBs

  See:
  See:“Planning Ballot Media Quantities” on 

page 24.

• Select the desired Quantity, Card Type 
and Mode options.

• Click the  button and 
follow the prompts to create media.

  See:
  See:“Planning for eScan Use” on page 21. 

 
 “Planning for Demonstration eSlate Use” 
on page 23.

Steps: Details:
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44. Print reports. Go to the Reports menu and click, at 
minimum, the following:
• Audit Trail to view and print a report 

giving a record of operator actions
• Media Production List to view and print 

a report documenting all media produced 
by sequential serial number, card type, 
time created, and card mode.

• Polling Place List/Early Voting/
Summary and Polling Place List/ 
Election Day/Summary to view and print 
reports necessary for warehouse/support 
personnel or JBC operators to assign 
polling place IDs to JBCs.

If the eScan is to be used in Absentee 
mode, obtain the Absentee polling place ID 
by viewing the Polling Places tab in the 
Jurisdiction window after generating with 
paper ballot template(s).

45. Verify that the MBBs and Audio cards 
contain the required information in the 
desired format.

View/listen to test mode cards on the JBC 
and DAU eSlate, eScan, and/or with Ballot 
Now.
Conduct a Logic and Accuracy Test (L&A).

  See:
  See:The Tally Training Manual for instructions 

on conducting an L&A with the system.

46. If necessary, copy the database forward 
(naming it according to conventions), 
delete the defective version, make 
corrections in the new database, and 
repeat necessary steps.

  See:
  See:“Database Management” on page 9.

“Appendix F: Copying Forward a BOSS 
Database” on page 117.

Steps: Details:
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47. As a risk-reduction measure, archive the 
database and save to CD.

Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn the database to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

48. Finalize the BOSS database for Tally. Once the BOSS database is finalized, 
media can no longer be created from this 
database.

Verify that all necessary media has been 
created.
Go to the Administration menu and click 
Finalize Election for Tally.

49. As a risk-reduction measure, archive the 
database and save to CD.

Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Follow prompts to navigate to the target 

location.
• Name and time-stamp, and then save the 

database.
• Burn the database to CD.
• Repeat this process after database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

50. Exit BOSS.

Steps: Details:
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Notes:



BOSS Training Manual 6300-002 62C

Page 48 Chapter 2   Creating a General or Special Election © Hart InterCivic, Inc.

Notes:
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Chapter 3

Creating a Primary Election

Follow the steps outlined in this chapter in order to create a closed primary or modified closed primary 
election. Modified open primary elections (pick-a-party) are created as if a general election, using 
contest dependencies per party choice.

  See:
  See:“Establishing Election Types and Organization Within BOSS” on page 13.

Refers to steps that are unique to creating a primary election. These steps vary from those for 
creating a general or special election.

Steps: Details:

1. Double-click the BOSS desktop shortcut 
to open the application.

OR Go to Start/Programs/Hart InterCivic/BOSS

2. Log in to BOSS as a user with all 
permissions.
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3. If you haven’t already done so, set up 
BOSS users and permission levels.

Go to the Administration menu and click 
Non-Election Tasks. Click Yes.
Go to the Administration menu and click 
Users Maintenance.

  See:
  See:“Establishing BOSS User Permissions” on 

page 12.

4. Create a BOSS database named 
“<Description # Election Type date>”.

Go to the File menu and click Open 
Database. In the Open Database window, 

click the  button.
In the Create Database window that appears, 
select a database to copy from, and complete 
the New Database Description field with a 
description of the database, the sequence 
number, the election name, and the date.
To create a blank database, copy the 
database from “(New Database)” (shown).
Click OK.

  See:
  See:Suggested naming conventions in 

“Database Management” on page 9.

5. Open the new BOSS database. In the Open Database window, double-click the 
target database.

6. Define the primary election jurisdiction 
information.

The Jurisdiction tab in the Jurisdiction 
window opens when you open a database.
Defining Jurisdiction information includes:
• Election Title for the header of the ballot

• Closed Primary or Modified Closed 
Primary Election Type (does not appear 
on the ballot)

• Election Date for the header of the ballot
• State Code (does not appear on the ballot)
• Jurisdiction Organization
• Jurisdiction Title for the header of the 

ballot
• Use of the Incumbent Indicator on reports
• Write-in label to appear on the ballot
• Precinct label to appear on the ballot

Steps: Details:
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7. Define primary election political parties 
and primary ballot headers.

Click the  button.
Code is a required field. It will not appear on 
ballots. It is for organizational purposes.
Party Name is not a required field. Text 
entered in this field will appear on the ballot in 
association with candidates assigned to the 
party code.

• Leave this field blank in order to use the 
Party Code as a ballot organizer and 
reporting tool , but to avoid having 
candidate names show party affiliations on 
the ballot.

Primary Ballot Header is not a required field. 
Text entered in this field will appear on the first 
line of the ballot.
Click OK to save data and close the window.

“NP” is a default Party Code in BOSS. 
This Party cannot be deleted, but it can be 
ignored by not associating any data with it, 
if necessary.

In a modified closed primary election, the 
Nonpartisan Party, regardless of actual 
title, must be associated with the “NP” 
code.

In a closed primary election, the “NP” 
Party Code may be used for contests and 
candidates, but Nonpartisan-only ballot 
styles may not be created, and 
Nonpartisan-only polling places may not 
be set up.

  See:
  See:“Establishing Election Types and 

Organization Within BOSS” on page 13.

Steps: Details:
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8. Select the languages to appear on ballots. Click the  button.
Select checkboxes to create ballots in 
languages other than English.
• Selected languages will have files for 

translation available for export on the 
Translation and Recording Export/
Import tab of the Import/Export window.

Select the Reuse English Candidate Name 
in Every Language checkbox in order to use 
only the English version of candidate names, 
and to withhold this data from exports for 
translation (i.e., no transliteration).
Select the Reuse English Candidate Details 
in Every Language checkbox in order to use 
only the English version of candidate details.
This data is not included in import files.
Click OK to save data and close the window.

  See:
  See:“Translating Foreign Language Ballot Text” 

on page 18.

9. Complete ballot instructions. Click the  button.
Ballot instructions include:
• eSlate instructions to appear at the top of 

the DRE ballot.
• eSlate audio instructions associated with 

the text for the top of the DRE ballot. 
• Ballot Now instructions to appear at the 

top of the Ballot Now and eScan paper 
ballots.

You can copy ballot instructions from a .txt file 
and paste them into BOSS fields. Use an 
ASCII font such as Arial or Times New 
Roman. Do not use Unicode fonts.
Click OK to save data and close the window.

Steps: Details:
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10.  Define eSlate options. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the Judge’s Booth 

Controller (JBC) operator a warning if s/he 
attempts to close or suspend the polls 
early, but it does not prevent such action.

• This data is not included in import files.
Early Voting suspend times should reflect 
the latest possible site suspend time.

Define the number of minutes the Access 
Code will be active after printing. (Required)
• 30 minutes is the default setting.
Select the Retrievable Early Voting Ballots 
option in accordance with applicable election 
codes.
• This associates a Ballot Code with all 

early voting ballots, making these ballots 
available for exclusion from tabulation.

• This data is not included in import files.
Select a Summary/Verification font size.
Select the Allow Tally and Allow Write-In 
Report Print checkboxes in order to allow the 
JBC operator to print tabulation and write-in 
reports after closing polls on Election Day. 
The Allow Tally box is checked by default.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select the VBO Required option in 
accordance with applicable election codes.
Select the number of times a ballot printout 
can be rejected in the VBO Ballot Rejection 
Limit field. The printout can be rejected a 
maximum of five times.
Select the Print Ballot Key option in 
accordance with applicable election codes. 
The box is checked by default.
Enter eSlate Passwords. (Required)
• eSlate passwords must be uppercase and/

or numeric, six (6) characters.
• This data is not included in import files.

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Click OK to save data and close the window.

Steps: Details:
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11. Define eScan options, if applicable. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the eScan operator a 

warning if s/he attempts to close or 
suspend the polls early, but it does not 
prevent such action.

• This data is not included in import files. 

Early Voting suspend times should reflect 
the latest possible site suspend time.

Enter eScan Passwords. (Required)
• eScan passwords must be numeric, six (6) 

characters.
• This data is not included in import files. 

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Select the Allow Tally Report Print checkbox 
to print the eScan tally tape.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select Ballot Processing permissions. 

Review ballot processing permission 
selections with elections officials. These 
settings determine who is allowed override 
permissions on the eScan device.

  See:
  See:“Planning for eScan Use” on page 21.

Click OK to save data and close the window.

12. Save Jurisdiction tab data. Click Save to save changes before exiting any 
window or tab in BOSS.
• You are prompted to save if you make 

changes and try to exit the window or tab.

Steps: Details:



6300-002 62C BOSS Training Manual

© Hart InterCivic, Inc. Chapter 3   Creating a Primary Election Page 55

13. Define precincts. In the Jurisdiction window, click the 
Precincts tab to define precincts, splits, and 
the number of registered voters per party, per 
precinct/split.
• The number of registered voters must be 

entered by party.
• The Voters field will display the aggregate 

total for all parties per precinct or split.
• Arrow buttons move the selected row.

14. Define districts and assign precincts, if 
applicable.

In the Jurisdiction window, click the Districts 
tab to define districts and assign precincts to 
districts.
• Precincts and splits can be assigned to 

multiple districts
• Arrow buttons add or remove precincts. 

Steps: Details:
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15. Define closed primary election contests.

In the Jurisdiction window, click the 
Contests tab to define contests and Ballot 
Text, and to assign districts or precincts to 
contests.

• Use the Contest Description field as an 
organizational tool to identify Party 
affiliations for contests.

• The Active Contest Details window is 
available for each contest by double-
clicking on the target contest.

• Arrow buttons add or remove districts

16. OR Define modified closed primary 
election contests.

In the Jurisdiction window, click the 
Contests tab to define contests and Ballot 
Text, and to assign districts or precincts to 
contests.

• Use the Contest Description field as an 
organizational tool to identify Party 
affiliations for contests.

• The Active Contest Details window is 
available for each contest by double-
clicking on the target contest.

• Arrow buttons add or remove districts

17. Define precinct-level contests, if 
applicable.

In the Jurisdiction window, click the 
Precinct-Level Contests tab to define 
contests and Ballot Text, and to assign 
precincts to contests.

• Use the Contest Description field as an 
organizational tool to identify Party 
affiliations for contests.

  Tip(s):
Precinct-Level contests in an election 
organized by districts can be included as 
single-precinct districts.

Steps: Details:
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18. Define closed primary election polling 
places.

In the Jurisdiction window, click the Polling 
Places tab to define polling places and assign 
precincts to polling places.

In a closed primary election, polling places 
may be identified as party-specific or as 
shared by all parties via the Party Code drop-
down window.

Party-specific polling places will have one 
JBC assigned to each party and only that 
party’s ballot styles will be available at that 
JBC.

Shared polling places will have all parties 
available per JBC, and the JBC operator will 
assign each voter his or her correct ballot 
style (party).

• Election Day precincts assigned to shared 
polling places are removed from the list of 
Available Precincts for all parties

• Election Day precincts assigned to party-
specific polling places are removed from 
the list of Available Precincts for those 
parties already assigned

• Early Voting precincts may be assigned to 
multiple polling places

• Arrow buttons add or remove precincts. 

Steps: Details:
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19. OR Define modified closed primary 
election polling places.

In the Jurisdiction window, click the Polling 
Places tab to define polling places and assign 
precincts to polling places.

In a modified closed primary election, precinct 
assignments to polling places work as in a 
general or special election.

The JBC operator will assign each voter his or 
her correct ballot style (party).
• Election Day precincts assigned are 

removed from the list of Available 
Precincts

• Early Voting precincts may be assigned to 
multiple polling places

• Arrow buttons add or remove precincts. 

20. Select ballot rotation type. In the Jurisdiction window, click the Rotation 
tab to define rotation type. 
• No Rotation is an available option.
• A rotation index of “0” equals ballot order 

as presented in the Active Contests 
window.

• In California databases, the  button 

appears.

  See:
  See:The BOSS Operations Manual for more 

information about ballot rotation.

Steps: Details:
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21. Add primary election contest details in the 
Active Contests window.

Go to the Election menu and click Active 
Contests.
Actions available in the Active Contests 
window include:
• Changing contest sequence with the 

arrow buttons
• Adding options (e.g., candidates)
• Associating parties with candidates

> For reporting purposes, you should 
associate parties with candidates in 
primary elections. You can avoid 
showing the party name for each 
candidate on the ballot by leaving the 
Party Name fields blank in the Party 
Maintenance window.

• Adding candidate details (e.g., delegates, 
occupations)

• Changing option sequence with the arrow 
buttons

Steps: Details:
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22. Edit primary election active contests in the 
Contest Details window.

Click the  button or 
double-click a contest to open the Contest 
Details window (also available from the 
Jurisdiction window, Contests tab).
Actions available in the Contest Details 
window include:
• Identifying contest type (straight party, 

office, proposition)

• Assigning Primary Party affiliation
> Assign each contest to the Party 

identified in the Contest Description 
field

• Enabling Rotation (checked and grayed 
when No Rotation is selected on the 
Rotation tab)

• Identifying cumulative contests
• Identifying fractional cumulative contests
• Identifying common contests (leave 

unchecked unless otherwise directed)

• Including contest in Nonpartisan ballots, if 
a modified closed primary election

• Identifying the number of valid choices 
and write-ins

• Adding contest-level instructions
• Adding Proposition Text
• Defining dependencies
• Forcing contest position
• Adding images to the ballot

  Note:
Force data is not imported.

Ballot Now contest position forces apply to 
all paper ballots (eScan and Ballot Now).

  See:
  See:“Ballot Images” on page 15.

The BOSS Operations Manual for more 
information about adding images.

Steps: Details:
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23. Proofread the available ballot reports, and 
make corrections if necessary.

Before generating, go to the Reports menu 
and click the following menu items:
• Active Contests to view the “Active 

Contests Options List” report
• Contest List to view the “Contest List with 

Details” report
• District Reports, Precinct Assignments 

to view the “Assigned Precinct Report”.

  Note:
“Ballot Content Proof” and ballot style 
reports are not available until after 
generating and accepting the ballot.

24. As a risk-reduction measure, back up 
BOSS data and the database.

24.1  Export all BOSS data files.

Go to the Election Menu, click Import/
Export, and then click the Export tab.
• Create an election folder with the date and 

time.
• Highlight (ALL) in the Select Element 

and Path/File to Export panel.

• Click the  button and navigate to the 
folder you created.

• Click the  button and 
respond to the dialog boxes that appear.

• Save export files to CD.
• Repeat this process after database 

changes.

  Note:
Page layout and password data are not 
exported.

24.2  Archive the database and save to CD. Go to the File menu and click Open 
Database.
• Create an election folder with the date and 

time.
• Highlight the target database.

• Click the  button.
• Follow prompts to navigate to the folder 

you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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25. (Optional) Prepare for ballot translation 
and transliteration by proofreading the 
existing ballots.

Go to the Election menu and click Ballot 
Formats. Click the Ballot Templates tab, 
choose one or more templates, and click the 
Generate Preview button. On the Ballot 
Preview tab, proofread each ballot style and 
click Reject when exiting the window.

26. Create four folders on the PC Desktop for 
data import and export.

Hart recommends that you give the folders the 
following names:
• Export Text
• Import Text
• Export Audio
• Import Audio

27. Export text for multi-language ballot 
translation, if applicable. If your ballot is in 
English only, proceed to step 32.

Go to the Election menu, click Import/
Export, and then click the Translation and 
Recording Export/Import tab.
Navigate to the Export Text folder and click 

the  button.

  See:
  See:The BOSS Operations Manual for detailed 

information about foreign language import/
export.

28. Move the contents of the Export Text 
folder into the Jobs folder.

  Note:
You must move files for translation into the 
Jobs folder in order for TRANS to 
recognize them.

29. Use TRANS to translate text for multi-
language ballots.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

30. Move the text files (.xlf) from the Jobs 
folder to the Import Text folder. 

  Note:
You must move the translated files from 
the Jobs folder in order to use them in 
BOSS.

Steps: Details:
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31. Import translated text for multi-language 
ballots.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Import Text folder and click 

the  button.

32. Export English text for recording in 
TRANS.

On the Translation and Recording Export/
Import tab of the Import/Export window, 
navigate to Export Audio folder and click the 

 button.
English audio prompts can be exported, 
recorded, and imported at any time after 
completing data entry and before generating 
the ballot.
English audio can be recorded while foreign 
language text is being translated.

  See:
  See:“Recording Audio” on page 19.

33. Export audio prompts for multi-language 
audio recording in TRANS, if applicable.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Export Audio folder and click 

the  button.

  See:
  See:“Translating Foreign Language Ballot Text” 

on page 18.

34. Move the contents of the Export Audio 
folder into the Jobs folder.

  Note:
You must move files for recording into the 
Jobs folder in order for TRANS to 
recognize them.

35. Use TRANS to record English and, if 
applicable, multi-language audio.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

36. Move the recorded audio files (.xml and 
.wav) to the Import Audio folder. 

  Note:
You must move the recorded files from the 
Jobs folder in order to use them in BOSS.

Steps: Details:
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37. Import recorded audio files. On the Translation and Recording Import/
Export tab of the Import/Export window:
• Click the “Enter import path for all audio 

files” radio button to import multiple audio 
files for a multi-language ballot.

• Click the “Enter import filepath name for 
one audio file” radio button to import one 
audio file for an English-only ballot.

Navigate to the Audio Import folder and click 

the  button.

38. Verify that the ballot is complete. Go to the Election menu and click Ballot 
Formats.
View the Ballot Data Validation tab to verify 
that the ballot is complete.
• A green circle indicates that the 

information is complete.
• A yellow triangle indicates that information 

is incomplete, but you can still generate 
the ballot.

• A red square indicates that the information 
is incomplete and you cannot generate the 
ballot until you supply the missing 
information.

39. As a risk-reduction measure, back up 
BOSS data and the database.

39.1  Export all BOSS data files.

Create an election folder with the date, time, 
and contents (in this case, BOSS data files).
Go to the Election Menu, click Import/
Export, and then click the Export tab.
• Highlight (ALL) in the Select Element 

and Path/File to Export panel.

• Click the  button and navigate to the 
folder you created.

• Click the  button and 
respond to the dialog boxes that appear.

• Save the export files to CD.
• Repeat this process after the database 

changes.

Steps: Details:



6300-002 62C BOSS Training Manual

© Hart InterCivic, Inc. Chapter 3   Creating a Primary Election Page 65

39.2  Export all translated text and recorded 
audio.

Create an election folder with the date, time, 
and contents (in this case, translated text and 
audio).
After completing translations and audio, 
export ALL foreign language text and ALL 
audio from the Translation and Recording 
Export/Import tab.
• Navigate to the folder you created and 

click the  
button.
Deselect the  
checkbox.

• Navigate to the folder you created and 

click the  
button.

• Save the export files to CD.
• Repeat this process after the database 

changes.

39.3  Archive the database and save to CD. Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:



BOSS Training Manual 6300-002 62C

Page 66 Chapter 3   Creating a Primary Election © Hart InterCivic, Inc.

40. Select templates and preview ballots. Go to the Election menu and click Ballot 
Formats.
Click the Ballot Templates tab and choose 
templates and paper size.
• Select paper ballot (Ballot Now/eScan) 

and eSlate DRE ballots in all formats and 
languages needed.

• If images have been added to the ballots, 
choose image-enabled templates. To 
obtain these templates, contact Hart 
InterCivic.

• Take written note of template(s) selected.
If  choosing paper ballot templates for use 
with the eScan, you must create passwords 
in the eScan Options window. Although 
eScan cannot be operated without 
passwords, it is possible to generate the 
ballot in BOSS without defining eScan 
passwords.
The eScan device does not accept 11x17 
ballots.

• Click the  button.

41. Proofread the ballot on the Ballot Preview 
tab.

Print ballot previews in order to proofread all 
formats, ballot styles, and languages, before 
accepting ballot generation.
Determine the maximum length of any ballot, 
and consider revising format to reduce length 
(e.g., to keep paper ballots to one sheet).

  Tip(s):
Right-click the ballot image and choose 
Save Picture As... in order to save the 
ballot page as a “*.bmp” graphic file (for 
use in sample ballot flyers, for example).

Steps: Details:
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42. Generate the ballot, or go back to make 
corrections.

Once you accept the ballot, you cannot 
enter new data in this BOSS database.

To accept ballot generation, click the 

 button on the 
Ballot Preview tab.
• Confirm ballot acceptance in the dialog 

box that appears.
To reject ballot generation, close the Ballot 
Generation/Preview window and click 
Reject.

43. If you haven’t already done so, insert the 
eCM into a USB port and complete 
acceptance of ballot generation.

Before accepting ballot generation, the BOSS 
application will prompt you to enter the eCM 
PIN.

The eCM can be removed from the USB port 
after the ballot has been accepted.
Store the eCM in a secure location.

44. Print Ballot Style reports. Go to the Reports menu and click the 
following menu items:
• Ballot Content Proof to view and print a 

report detailing precincts, contests, and 
registered voters per ballot style

• Ballot Style by District to view and print 
a report detailing all ballot styles and 
associated districts and precincts

• Ballot Style by Precinct to view and print 
a report detailing all ballot styles and 
assigned precincts (for election organized 
by precinct-contest associations)

Steps: Details:
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45. Create the Mobile Ballot Boxes (MBBs) for 
use in the JBCs, eScan devices, Ballot 
Now PCs, and SERVO, Audio cards for 
DAU eSlates, and/or Demo cards for 
eSlate Demonstration units.

Go to the Election menu and click Write 
Ballot Media. 

Decide the number of cards needed for the 
election, including recovery and SERVO 
MBBs. 

  See:
  See:“Planning Ballot Media Quantities” on 

page 24.

• Select the desired Quantity, Card Type 
and Mode options

• Click the  button and 
follow the prompts to create media.

  See:
  See:“Planning for eScan Use” on page 21. 

 
 “Planning for Demonstration eSlate Use” 
on page 23.

46. Print reports. Go to the Reports menu and click, at 
minimum, the following:
• Audit Trail to view and print a report 

giving a record of operator actions
• Media Production List to view and print a 

report documenting all media produced by 
sequential serial number, card type, time 
created, and card mode.

• Polling Place List/Early Voting/
Summary and Polling Place List/ 
Election Day/Summary to view and print 
reports necessary for warehouse/support 
personnel or JBC operators to assign 
polling place IDs to JBCs.

If the eScan is to be used in Absentee 
mode, obtain the Absentee polling place ID 
by viewing the Polling Places tab in the 
Jurisdiction window after generating with 
paper ballot template(s).

Steps: Details:
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47. Verify that the MBBs and Audio cards 
contain the required information in the 
desired format.

View/listen to test mode cards on the JBC and 
DAU eSlate, eScan, and/or with Ballot Now.
Conduct a Logic and Accuracy Test (L&A).

  See:
  See:The Tally Training Manual for instructions 

on conducting an L&A with the system.

48. If necessary, copy the database forward 
(naming it according to conventions), 
delete the defective version, make 
corrections in the new database, and 
repeat necessary steps.

  See:
  See:“Database Management” on page 9.

“Appendix F: Copying Forward a BOSS 
Database” on page 117.

49. As a risk-reduction measure, archive the 
database and save to CD.

Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn the database to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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50. Finalize the BOSS database for Tally. Once the BOSS database is finalized, 
media can no longer be created from this 
database.

Verify that all necessary media has been 
created.
Go to the Administration menu and click 
Finalize Election for Tally.

51. As a risk-reduction measure, archive the 
database and save to CD.

Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Follow prompts to navigate to the target 

location.
• Name and time-stamp, and then save, the 

database.
• Burn the database to CD.
• Repeat this process after the database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

52. Exit BOSS.

Steps: Details:



6300-002 62C BOSS Training Manual

© Hart InterCivic, Inc. Chapter 3   Creating a Primary Election Page 71

Notes:
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Notes:
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Chapter 4

Using Imported Data to Create an Election 

Overview of the Data Import Process
You can create BOSS databases by manually entering data in BOSS as shown in the previous chapters, 
or by importing ASCII text files through the Import tab of the Import/Export window. This chapter 
outlines procedures for creating a BOSS database by importing data files.

Guidelines Regarding Data Entry Methods
You can build a BOSS database with a mix of imported ASCII data and data manually entered through 
the BOSS user interface. ASCII text files show the data in tab-delimited fields and may only contain 
numeric values and English text. Some BOSS windows require updating in the BOSS GUI after a data 
import.

File Formats
BOSS data import files are ASCII text files containing records of tab-delimited fields. These files might be 
exports from a previous BOSS database, exports from a voter registration system, or files created in MS 
Excel and saved as tab-delimited text files.

• It is not necessary that non-numeric (character, variable character) fields be enclosed by double 
quotation marks, unless it is intended for a tab character to be part of the field. 

• All imported external IDs will be imported as system IDs and used for processing and export 

identifiers when the  checkbox is selected. If import file external IDs 
are numeric, this checkbox should be selected.

• All imported external IDs are preserved in BOSS, and BOSS creates its own set of unique 

identifiers upon import when the  checkbox is not selected. BOSS 
uses these unique identifiers for processing and export identifiers. If import file external IDs are 
alphanumeric, this checkbox should not be selected.

• If creating data files, refer to the file format tables in the BOSS Operations Manual. Note the 
following data type descriptions:
> “Varchar” (alphanumeric variable character) data fields are those that have a limited 

character length
> “Char” (alphanumeric character) data fields are those that have a required character length
> “Integer” (positive whole number) data fields have required number values and associations
> “TinyInt” (positive whole number) data fields are those that have required number values of 

“0” or “1”
> “Numeric” data fields are fields containing number values
> “Unsigned Int” (non-negative whole number) data fields have required number values and 

associations.
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Data File Contents

The following table lists the data files that may be imported into, or exported from, BOSS through the 
Import and Export tabs in the Import/Export window. Data files are listed here in the order they appear 
in the tabs. 

  See:
  See:The BOSS Operations Manual for specific information on import/export data files and file formats. 

Data File (File Name): Related BOSS Window/Tab:

Election Data (ELECTION) Jurisdiction window, Jurisdiction and Rotation tabs, 
and eSlate Options window

Party List (PARTY) Party Maintenance window

Ballot Instructions 
(BALLOT_INSTRUCTION)

Ballot Instructions window

Polling Places (POLLING_PLACE) Polling place and party data in the Jurisdiction window, 
Polling Places tab

Precincts (PRECINCT) Precinct and aggregated registered voter data per precinct 
in the Jurisdiction window, Precincts tab

Party Precinct Voters 
(PARTY_VOTERS)

Party-specific registered voter data per precinct in the 
Jurisdiction window, Precincts tab

Polling Place and Precinct Associations 
(POLLING_PLACE_AND_PRECINCT)

Precinct-to-polling place data in the Jurisdiction window, 
Polling Places tab

Districts (DISTRICT) District data for the Jurisdiction window, Districts tab

Precinct and District Associations 
(PRECINCT_AND_DISTRICT)

Precinct-to-district data in the Jurisdiction window, 
Districts tab

Contests (CONTEST) Contest data in the Jurisdiction window, Contests tab, 
Active Contests window, and Contest Details window

District and Contest Associations 
(DISTRICT_AND_CONTEST)

District-to-contest data in the Jurisdiction window, 
Contests tab for precinct/district/contest elections

Precinct-Level Contests 
(PRECINCT_LEVEL_CONTEST)

Contest data in the Jurisdiction window, Precinct-Level 
Contests tab, Active Contests window, and Contest 
Details window

Precinct and Precinct-Level Contest 
Associations (PLC_AND_PRECINCT)

Precinct-to-contest data in the Jurisdiction window, 
Precinct-Level Contests tab

Candidates (CANDIDATE) Candidate data in the Active Contests window

Candidate Details 
(CANDIDATE_DETAIL)

Candidate detail data in the Active Contests window

Contest and Precinct Associations 
(CONTEST_AND_PRECINCT)

Contest-to-precinct data in the Jurisdiction window, 
Contests tab

Ballot Images (BALLOT_IMAGES) Ballot image data in the Add Image window
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Best Practices for Successful Data Import

The following are some recommendations and notes regarding importing data into BOSS. 

Initially, imports should be performed on a blank BOSS database created from the system default.

The following data elements are not imported, and must be entered via the BOSS GUI:
• Language choices for the ballot (enter via the Select Language Details window)
• Election Day Close Time (enter via the eSlate Options and eScan Options windows)
• Early Voting Suspend Time (enter via the eSlate Options and eScan Options windows)
• Retrievable Early Voting Ballots selection (enter via the eSlate Options window)
• eSlate and eScan Passwords (enter via the eSlate Options and eScan Options windows)
• eSlate Contest Position forces (enter via the Contest Details window)
• Ballot Now/eScan paper ballot Contest Position forces (enter via the Contest Details window)
The “Election Date” field in the “Election Data” file may not be prior to the current date set on the PC 
being used to create the database.
• If the “Election Date” field is prior to the current date, correct the date in the import file and re-

import (or use the “Repair” function in BOSS).

“Absentee” polling places associated with Ballot Now cannot be imported from the “Polling 
Places” or “Polling Place and Precinct Associations” data files. 

• If data files were created by exporting from a previously generated BOSS database that included 
Ballot Now formatting, delete the “Absentee” associated fields from the import files before 
importing (or use the “Repair” function in BOSS). BOSS automatically creates an “Absentee” 
polling place and precinct associations when a Ballot Now format is generated. 

It is most efficient to choose the import “ALL” option, rather than importing one data file at a time. If 
some data does not require replacement, click Cancel to skip those files.
It is most efficient to copy import data files to the directory C:\Boss\Import.
• This is the default location for BOSS import files, so using this directory allows you to avoid 

navigating to another location.
• By copying to this directory original data files are preserved in a separate location.
It is sometimes more efficient and effective to cancel the import process and correct the import file 
rather than attempting to repair the import data or commit without repair through the BOSS Import/
Export window, Import tab.
• Errors in the original import file can be viewed through the BOSS Import/Export window, Import 

tab without necessitating repairing from that location or committing without repair.
• Correcting the original import file directly ensures that the import file is an accurate record of the 

actual data in BOSS.
• Committing the defective import without repair may lead to database, or ballot style, errors 

because of missing data.
• Once the import “ALL” process is stopped in order to make a repair, all following imports must 

proceed one data file at a time (this slows down the process).

  Tip(s):
The “Repair” function may be used successfully to complete import processes without correcting 
source files. If this is done, the data should then be exported from BOSS in order to create new 
source data files reflecting the contents of the BOSS election database.
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Data Import Procedures

Procedures are presented here in brief. General, Special, and Primary elections can be created via data 
imports. The examples here show a General Election. 

  See:
  See:The BOSS Operations Manual for detailed information on performing data imports.

Steps: Details:

1. Double-click the BOSS desktop shortcut 
to open the application.

OR Go to Start/Programs/Hart InterCivic/BOSS

2. Log in to BOSS as a user with all 
permissions.

3. If you haven’t already done so, set up 
BOSS users and permission levels.

Go to the Administration menu and click 
Non-Election Tasks. Click Yes.
Go to the Administration menu and click 
Users Maintenance.

  See:
  See:“Establishing BOSS User Permissions” on 

page 12.
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4. Create a BOSS database named 
“<Description # Election Type date>”.

Go to the File menu and click Open 
Database. In the Open Database window, 

click the  button.
In the Create Database window that appears, 
select a database copy from, and complete 
the New Database Description field with a 
description of the database, the sequence 
number, the election name, and the date.
To create a blank database, copy the 
database from “(New Database)”.
Click OK.

  See:
  See:Suggested naming conventions in 

“Database Management” on page 9.

5. Open the new BOSS database. In the Open Database window, double-click the 
target database.

6. Create or obtain import files and copy to 
C:\Boss\Import.

File source may be
• BOSS database export
• MS Excel documents saved as tab-

delimited text files
• Voter registration system
• Election management system
• Other
All BOSS ballot data import files are ASCII 
text files containing records of tab-delimited 
fields.

  Note:
If importing via the import “ALL” function in 
BOSS, filenames must match those 
shown. If importing one data file at a time, 
you may vary filenames and navigate to 
one file at a time.

Steps: Details:
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7. Go to the Election menu, click Import/
Export, and then click the Import tab.

The database is empty at this point.
The BOSS default database includes the “NP” 
party code, so the Party List appears 
completed, as indicated by the green circle.
Verify the following settings:
• (ALL) is highlighted

•   is selected if 
external ID data is numeric

•  displays 
as the filepath

> If necessary, click the  button to 
navigate to the folder containing your 
import data.

8. Begin importing ballot data.
Click the  button.

9. Respond to prompts confirming import 
processes.

BOSS will proceed down the list of data files in the 
target location and listed in the Select Element 
and Path File to Import panel.

Steps: Details:
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10. When importing the Party.txt file the 
Records Already Exist for the Data 
Element dialog window appears. 

The BOSS default database includes the “NP” 
party code, so the data from the Party.txt file 
appears as if completed.

• Click the  button if the 
import file does not include an “NP”-Code- 
associated-party (i.e., you are adding 
parties, but the import file does not include 
the existing “NP” party).

• Click the  button if the 
import file DOES include the “NP”-Code-
associated-party (e.g., you are adding a 
Party Name for the “NP” party).

• Click the  button if you 
are uncertain of the contents of the 
Party.txt file. This file will be skipped.

11. Confirm import of the Precinct.txt data. Read and respond to prompts as the data 
import process continues.

  Note:
The Precinct.txt file in the example shown 
has “0” voters in the “Voters” data element 
fields.

This aggregate number will be overwritten 
by the sum of the voters in all political 
parties for each precinct when the 
Party_Voters.txt file is imported.

Steps: Details:
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12. Proceed to update the registered voter 
data with the Party_Voters.txt import. Click the  button to update the 

number of registered voters per precinct in the 
Precinct.txt import file with the aggregated 
numbers per precinct per party from the 
Party_Voters.txt import file. 
• The BOSS database will include both an 

aggregate of registered voters per precinct 
AND voters by party per precinct, and 
these numbers will agree. 

Click the  button if you are 
uncertain of the contents of the registered 
voter numbers in the Precinct.txt and 
Party_Voters.txt files. The Party_Voters.txt file 
will be skipped.

13. When BOSS encounters large import files, 
the BOSS FastLoad! dialog window 
appears.

Click the  button to proceed.
• Fastload simply bypasses the step of 

displaying the import file data on the 
import tab GUI, thus making the data 
processing more efficient.

OR Click the  button to proceed 
and display data as it is imported. 
Read and respond to prompts as the data 
import process continues.

14. IF BOSS encounters invalid records, a 
dialog window describing the error 
appears first. 

Click the  button.

Steps: Details:
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15. IF BOSS encounters invalid records, 
continue as if repairing the file. Click the  button.

• This allows you to view the Invalid 
Record List.
> You can identify and resolve the error 

in the source document.
> OR You can correct the error using the 

“Repair” function.

16. IF BOSS encounters invalid records, the 
Invalid Record List displays.

View the Error Detail panel. Take note of the 
details:
• Error type
• Row/column
• Error messages

Click the  button and 
proceed to correct the error in the source file.

OR Click the  button 

and then the  button 
and follow prompts to repair the data from the 
file.

  Tip(s):
If repairing the data as described here, 
export all data after successfully 
completing import. This will create new 
source files.

17. IF correcting the source file, open the 
source file and correct the error.

In this example, the last row included a 
candidate with no candidate name.
Correct the error, save the changes in the 
original file, copy to C:/Boss/Import, and 
return to the Import tab of the Import/Export 
window.

Steps: Details:
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18. IF correcting 
the source file, 
select (ALL) 
and continue 
data import.

Click the  button.
Read and respond to prompts to replace, 
append, or cancel/skip existing data as the 
data import process continues.

  Tip(s):

Click the   button to skip 
data files already successfully imported. 
The import of that file is cancelled, and 
BOSS skips to the next file in the list.

19. Confirm import of corrected data. Read and respond to prompts as the data import 
process continues.

Steps: Details:
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20. Complete ballot data imports. Read and respond to prompts until the data 
import process is completed.

21. Select languages for the ballot, if 
applicable.

Go to the Jurisdiction window and click the 

 button on the  
Jurisdiction tab.
Select checkboxes to create ballots in 
languages other than English.
Select the Reuse English Candidate Name 
in Every Language checkbox in order to use 
only the English version of candidate names, 
and to withhold this data from exports for 
translation (i.e., no transliteration).
Select the Reuse English Candidate Details 
in Every Language checkbox in order to use 
only the English version of candidate details.
This data is not included in import files.
Click OK to save data and close the window.

22. Complete ballot instructions, if necessary. Click the  button.
Ballot instructions include:
• eSlate instructions to appear at the top of 

the DRE ballot.
• eSlate audio instructions associated with 

the text for the top of the DRE ballot. 
• Ballot Now instructions to appear at the 

top of the Ballot Now and eScan paper 
ballots.

You can copy ballot instructions from a .txt file 
and paste them into BOSS fields. Use an 
ASCII font such as Arial or Times New 
Roman. Do not use Unicode fonts.
Click OK to save data and close the window.

Steps: Details:
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23. Define eSlate options. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the Judge’s Booth 

Controller (JBC) operator a warning if s/he 
attempts to close or suspend the polls 
early, but it does not prevent such action.

• This data is not included in import files.
Early Voting suspend times should reflect 
the latest possible site suspend time.

Define the number of minutes the Access 
Code will be active after printing. (Required)
• 30 minutes is the default setting.
Select the Retrievable Early Voting Ballots 
checkbox in accordance with applicable 
election codes.
• This associates a Ballot Code with all 

early voting ballots, making these ballots 
available for exclusion from tabulation.

• This data is not included in import files.
Select a Summary/Verification font size.
Select the Allow Tally and Allow Write-In 
Report Print checkboxes in order to allow the 
JBC operator to print tabulation and write-in 
reports after closing polls on Election Day. The 
Allow Tally box is checked by default.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select the VBO Required option in 
accordance with applicable election codes.
Select the number of times a ballot printout 
can be rejected in the VBO Ballot Rejection 
Limit field. The printout can be rejected a 
maximum of five times.
Select the Print Ballot Key option in 
accordance with applicable election codes. 
The box is checked by default.
Enter eSlate Passwords. (Required)
• eSlate passwords must be uppercase and/

or numeric, six (6) characters.
• This data is not included in import files.

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Click OK to save data and close the window.   

Steps: Details:



6300-002 62C BOSS Training Manual

© Hart InterCivic, Inc. Chapter 4   Using Imported Data to Create an Election Page 85

24. Define eScan options, if applicable. Click the  button.
Define Election Day and Early Voting close 
and suspend times. (Optional)
• Use 24-hour clock settings.
• This option gives the eScan operator a 

warning if s/he attempts to close or 
suspend the polls early, but it does not 
prevent such action.

• This data is not included in import files. 

Early Voting suspend times should reflect 
the latest possible site suspend time.

Enter eScan Passwords. (Required)
• eScan passwords must be numeric, six (6) 

characters.
• This data is not included in import files. 

Document passwords in a secure location 
and share with support and poll worker 
resources as needed. Passwords are not 
viewable via BOSS reports or data export.

Select the Allow Tally Report Print checkbox 
to print the eScan tally tape.
Select the Combine Split Precincts for 
Report and Include Provisional Ballots in 
Vote Totals checkboxes in accordance with 
applicable election codes.
Select Ballot Processing permissions. 

Review ballot processing permission 
selections with elections officials. These 
settings determine who is allowed override 
permissions on the eScan device.

  See:
  See:“Planning for eScan Use” on page 21.

Click OK to save data and close the window.

Steps: Details:
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25. Select contest position force settings. Go to the Contest Details window for each 
contest requiring a position force.
• This setting is usually not made until 

ballots have been previewed.
• The selected contest will be the first 

displayed in the forced position.
• eSlate and Ballot Now contest positions 

are forced separately.
This data is not included in import files.

  Note:
Ballot Now contest position forces apply to 
all paper ballots (eScan and Ballot Now).

26. Proofread the available ballot reports, and 
make corrections if necessary.

Before generating, go to the Reports menu 
and click the following menu items:
• Active Contests to view the “Active 

Contests Options List” report
• Contest List to view the “Contest List with 

Details” report
• District Reports, Precinct Assignments 

to view the “Assigned Precinct Report”.

  Note:
“Ballot Content Proof” and ballot style 
reports are not available until after 
generating and accepting the ballot.

27. (Optional) Prepare for ballot translation by 
proofreading the existing ballots.

Go to the Election menu and click Ballot 
Formats. Click the Ballot Templates tab, 
choose one or more templates, and click the 
Generate Preview button. On the Ballot 
Preview tab, proofread each ballot style and 
click Reject when exiting the window.

28. Create four folders on the PC Desktop for 
data import and export.

Hart recommends that you give the folders the 
following names:
• Export Text
• Import Text
• Export Audio
• Import Audio

Steps: Details:
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29. Export text for multi-language ballot 
translation, if applicable. If your ballot is in 
English only, proceed to step 34.

Go to the Election menu, click Import/
Export, and then click the Translation and 
Recording Export/Import tab.
Navigate to the Export Text folder and click 

the  button.

  See:
  See:The BOSS Operations Manual for detailed 

information about foreign language import/
export.

30. Move the contents of the Export Text 
folder into the Jobs folder.

  Note:
You must move files for translation into the 
Jobs folder in order for TRANS to 
recognize them.

31. Use TRANS to translate text for multi-
language ballots.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

32. Move the text files (.xlf) from the Jobs 
folder to the Import Text folder. 

  Note:
You must move the translated files from 
the Jobs folder in order to use them in 
BOSS.

33. Import translated text for multi-language 
ballots.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Import Text folder and click 

the  button.

Steps: Details:
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34. Export English text for recording in 
TRANS.

On the Translation and Recording Export/
Import tab of the Import/Export window, 
navigate to Export Audio folder and click the 

 button.
English audio prompts can be exported, 
recorded, and imported at any time after 
completing data entry and before generating 
the ballot.
English audio can be recorded while foreign 
language text is being translated.

  See:
  See:“Recording Audio” on page 19.

35. Export audio prompts for multi-language 
audio recording in TRANS, if applicable.

On the Translation and Recording Import/
Export tab of the Import/Export window, 
navigate to the Export Audio folder and click 

the  button.

  See:
  See:“Translating Foreign Language Ballot Text” 

on page 18.

36. Move the contents of the Export Audio 
folder into the Jobs folder.

  Note:
You must move files for recording into the 
Jobs folder in order for TRANS to 
recognize them.

37. Use TRANS to record English and, if 
applicable, multi-language audio.

  See:
  See:The TRANS User Guide for detailed 

information about foreign language 
translation and recording.

38. Move the recorded audio files (.xml and 
.wav) to the Import Audio folder. 

  Note:
You must move the recorded files from the 
Jobs folder in order to use them in BOSS.

39. Import recorded audio files. On the Translation and Recording Import/
Export tab of the Import/Export window:
• Click the “Enter import path for all audio 

files” radio button to import multiple audio 
files for a multi-language ballot.

• Click the “Enter import filepath name for 
one audio file” radio button to import one 
audio file for an English-only ballot.

Navigate to the Audio Import folder and click 

the  button.

Steps: Details:
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40. Verify that the ballot is complete. Go to the Election menu and click Ballot 
Formats.
View the Ballot Data Validation tab to verify 
that the ballot is complete.
• A green circle indicates that the 

information is complete.
• A yellow triangle indicates that information 

is incomplete, but you can still generate 
the ballot.

• A red square indicates that the information 
is incomplete and you cannot generate the 
ballot until you supply the missing 
information.

41. As a risk-reduction measure, back up 
BOSS data and the database.

41.1  Export all BOSS data files.

Create an election folder with the date, time, 
and contents (in this case, BOSS data files).
Go to the Election Menu, click Import/
Export, and then click the Export tab.
• Highlight (ALL) in the Select Element 

and Path/File to Export panel.

• Click the  button and navigate to the 
folder you created.

• Click the  button and 
respond to the dialog boxes that appear.

• Save export files to CD.
• Repeat this process after database 

changes.

  Note:
Force data is not exported.

Steps: Details:
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41.2  Export all translated text and recorded 
audio.

Create an election folder with the date, time, 
and contents (in this case, translated text and 
audio).
After completing translations and audio, 
export ALL foreign language text and ALL 
audio from the Translation and Recording 
Export/Import tab.
• Navigate to the folder you created and 

click the  
button.
Deselect the checkbox.

• Navigate to the target export location and 

click the  
button.

• Repeat this process after database 
changes.

41.3  Archive the database and save to CD. Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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42. Select templates and preview ballots. Go to the Election menu and click Ballot 
Formats.
• On the Ballot Data Validation tab, verify 

that the ballot is complete.
• Click the Ballot Templates tab and 

choose templates and paper size.
> Select paper ballot (Ballot Now/eScan) 

and eSlate DRE ballots in all formats 
and languages needed.

> If images have been added to the 
ballots, choose image-enabled 
templates. To obtain these templates, 
contact Hart InterCivic.

> Take written note of template(s) 
selected. 

If choosing paper ballot templates for use 
with the eScan, you must create passwords 
in the eScan Options window. Although 
eScan cannot be operated without 
passwords, it is possible to generate the 
ballot in BOSS without defining eScan 
passwords. 

The eScan device does not accept 11x17 
ballots. 

• Click the  button.

43. Proofread the ballot on the Ballot Preview 
tab.

Print ballot previews in order to proofread all 
formats, ballot styles, and languages, before 
accepting ballot generation.
Determine the maximum length of any ballot, 
and consider revising format to reduce length 
(e.g., to keep paper ballots to one sheet).

  Tip(s):
Right-click the ballot image and choose 
Save Picture As... in order to save the 
ballot page as a “*.bmp” graphic file (for 
use in sample ballot flyers, for example).

Steps: Details:
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44. Generate the ballot, or go back to make 
corrections.

Once you accept the ballot, you cannot 
enter new data in this BOSS database.

To accept ballot generation, click the 

 button in the Ballot 
Preview tab.
• Confirm ballot acceptance in the dialog 

box that appears.
To reject ballot generation, close the Ballot 
Generation /Preview window and click 
Reject.

45. If you haven’t already done so, insert the 
eCM into a USB port and complete 
acceptance of ballot generation.

Before accepting ballot generation, the BOSS 
application will prompt you to enter the eCM 
PIN.

The eCM can be removed from the USB port 
after the ballot has been accepted.
Store the eCM in a secure location.

46. Print Ballot Style reports. Go to the Reports menu and click the 
following menu items:
• Ballot Content Proof to view and print a 

report detailing precincts, contests, and 
registered voters per ballot style

• Ballot Style by District to view and print 
a report detailing all ballot styles and 
associated districts and precincts

• Ballot Style by Precinct to view and print 
a report detailing all ballot styles and 
assigned precincts (for election organized 
by precinct-contest associations)

Steps: Details:
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47. Create the Mobile Ballot Boxes (MBBs) for 
use in the JBCs, eScan devices, Ballot 
Now PCs, and SERVO, Audio cards for 
DAU eSlates, and/or Demo cards for 
eSlate Demonstration units.

Go to the Election menu and click Write 
Ballot Media. 

Calculate the number of cards needed for 
the election, including recovery and 
SERVO MBBs.

  See:
  See:“Planning Ballot Media Quantities” on 

page 24.

• Select the desired Quantity, Card Type 
and Mode options.

• Click the  button and 
follow the prompts to create media.

  Tip(s):
“Planning for eScan Use” on page 21. 
 
 “Planning for Demonstration eSlate Use” 
on page 23.

48. Print reports. Go to the Reports menu and click, at 
minimum, the following:
• Audit Trail to view and print a report 

giving a record of operator actions
• Media Production List to view and print a 

report documenting all media produced by 
sequential serial number, card type, time 
created, and card mode.

• Polling Place List/Early Voting/
Summary and Polling Place List/ 
Election Day/Summary to view and print 
reports necessary for warehouse/support 
personnel or JBC operators to assign 
polling place IDs to JBCs.

If the eScan is to be used in Absentee 
mode, obtain the Absentee polling place ID 
by viewing the Polling Places tab in the 
Jurisdiction window after generating with 
paper ballot template(s).

Steps: Details:
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49. Verify that the MBBs and Audio cards 
contain the required information in the 
desired format.

View/listen to test mode cards on the JBC and 
DAU eSlate, eScan, and/or with Ballot Now.
Conduct a Logic and Accuracy Test (L&A).

  See:
  See:The Tally Training Manual for instructions 

on conducting an L&A with the system.

50. If necessary, copy the database forward 
(naming it according to conventions), 
delete the defective version, make 
corrections in the new database, and 
repeat necessary steps.

  See:
  See:“Database Management” on page 9.

“Appendix F: Copying Forward a BOSS 
Database” on page 117.

51. As a risk-reduction measure, archive the 
database and save to CD.

Create an election folder with the date, time, 
and contents (in this case, the archived BOSS 
database).
Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Navigate to the folder you created.
• Click Save.
• Burn this folder to CD.
• Repeat this process after database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

Steps: Details:
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52. Finalize the BOSS database for Tally. Once the BOSS database is finalized, 
media can no longer be created from this 
database.

Go to the Administration menu and click 
Finalize Election for Tally.
• Verify that all necessary media has been 

created.

53. As a risk-reduction measure, archive the 
database and save to CD.

Go to the File menu and click Open 
Database.
• Highlight the target database.

• Click the  button.
• Follow prompts to navigate to a 

specifically named and time-stamped 
folder.

• Click Save.
• Burn this folder to CD.
• Repeat this process after database 

changes.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 113.

54. Exit BOSS.

Steps: Details:
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Notes:
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Appendices

Appendix A: Glossary

Term: Definition:

Abandoned Ballot A ballot that the voter did not cast into the ballot box before leaving the polling 
place. On an eSlate, this is a ballot that the voter did not cast by pressing the 
CAST BALLOT button and the voter is not present. Local election rules dictate 
dispensation of an abandoned ballot.

Absentee Ballot An official ballot issued to a voter who will be "absent" from the polling place on 
Election Day. 

Absentee Voting A voting method by which people can cast their ballots without going to the 
polling place on Election Day. Early Voting is sometimes referred to as 
"Absentee-in-person," and by-mail voting is sometimes referred to as 
"Absentee-by-mail." 

Access Code The four-digit number given to each voter that indicates to the eSlate system 
which precinct and ballot style to display to the voter on the eSlate voting unit. 
The Access Code is printed on a slip of paper printed on the JBC.

Access Code 
Status Report

A JBC report that is printed on-demand. It lists the number of Access Codes 
issued, voted, expired, canceled, and active.

Access Code 
Summary

A JBC report that is printed with the “Tally” report when polls are closed on 
Election Day. It lists the number of Access Codes issued, voted, expired, and 
canceled. 

Americans with 
Disabilities Act 
(ADA)

A 1990 federal act (Public Law 101-336) that established comprehensive 
standards for the treatment of persons with disabilities in employment, public 
accommodations, and other programs, including those operated by state and 
local governments.

ATA Advanced Technology Attachment; a disk drive implementation that integrates 
the controller on the disk drive itself.

Audio Card Used in a DAU eSlate, the PC card that contains the audio prompt recordings 
for an election. Formerly also called a “DAU Card”.

Audit Log, Audit 
Trail, Audit Report

Recorded information that allows elections officials to view the steps that 
occurred on the equipment included in an election to verify or reconstruct the 
steps followed without compromising ballot or voter secrecy. 

Authentication The verification of the identity of a person or process. In a communication 
system, authentication verifies that messages really come from their stated 
source, like the signature on a (paper) letter.

Ballot Box, eScan A secure receptacle for the eScan that collects scanned paper ballots and that 
has an emergency compartment for temporary storage of voted ballots in case 
the eScan is disabled.
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Ballot Box 
Security Seal

The seal attached to the MBB door on a JBC or eScan to secure the installed 
MBB. Also, the seal attached to the lid/receptacle junction of the eScan ballot 
box.

Ballot Code A unique number assigned to either a provisional ballot or an Early Voting 
retrievable ballot to enable swift retrieval of that ballot from the Hart Voting 
System Tally application by election officials.

Ballot Format The arrangement of the ballot created in BOSS. Ballots may be formatted for 
the eSlate or for Ballot Now.

Ballot 
Instructions

Instructional text that appears at the top of the ballot. There are two separate 
types of Ballot Instruction text: (1) eSlate and (2) Ballot Now. There is also 
separate audio instruction associated with the eSlate ballot instruction.

Ballot Key The unique alphanumeric identifier associated with each VBO cast vote record. 
This identifier aids in reconciling votes in case of a manual recount.

Ballot Now ™ The Hart Voting System software application that prints paper ballots on 
demand and then digitally images the voted ballots to save for delivery to Tally.

Ballot Now Image 
Processor

Ballot Now Image Processor (BNIP) is an application that runs in parallel with 
Ballot Now. After scanning ballots, BNIP processes ballot images.

Ballot Origination 
Software 
System™ (BOSS)

The software application used to build an election database and create ballot 
styles. BOSS is used to write the MBB, Audio, Solo, and Demo cards used in 
Hart Voting System equipment.

Ballot Style One of any number of specific ballot configurations issued to the appropriate 
precinct. At minimum, ballot styles differ from one another in content. They may 
also differ in size of type, in language used, or in method of presentation (e.g., 
visual or audio).
A ballot with a unique collection of contests to be used in the election. Every 
precinct’s (or split precinct’s) ballot is linked to one ballot style and there may be 
several precincts with the same ballot style. The ballot style information is 
carried on the MBB. A ballot style barcode is printed on the ballot.

Ballot Text Instructional text embedded in the ballot. Ballot Text is often used to identify a 
section of the ballot.

Bar Code A printed horizontal strip of vertical bars of varying widths, groups of which 
represent decimal digits.  In the Hart Voting System, bar codes are required in 
order for paper ballots to be correctly scanned. Ballot Now uses bar codes to 
represent a ballot page’s election identifier (ID), party ID, language ID, precinct 
ID, sheet ID, serial number (if applied), page number, ballot type, and duplex 
code.

Card Device The PC-card drive for reading and writing Hart Voting System data and audio 
cards.

Cast Vote Record 
(CVR)

An anonymous record of the contest options that a voter selected on his/her 
cast ballot. In the Hart Voting System, Cast Vote Records are stored in 
electronic format. One Cast Vote Record is equivalent to one ballot.

Term: Definition:
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Challenged Ballot Terminology and rules for “challenged ballots” or “challenged voters” vary by 
state. In general, a challenged ballot results when a voter’s right to cast a ballot 
in a certain jurisdiction is challenged for various procedural reasons. If the 
challenge stands, the voter may, in most cases, vote provisionally.

Contest A choice to be made on the ballot; a race. Contest types include offices, issues, 
referendums, propositions and questions.

Credentials Authentication information that enables access to operations in the system or 
associated databases. Credentials typically include user IDs and passwords.

Cumulative 
(Access Code) 
Summary

A summary on the JBC “Suspend Report” or “Daily Detail Report” that lists the 
Access Codes issued, voted, expired, and canceled for the entire session of 
Early Voting.

Cumulative Voting The votes for each candidate in an office contest are replicated as many times 
as the number of valid choices.

Cyclic 
Redundancy 
Check

A continuous test of each transfer of data within a system to ensure that the 
data received at the end of the transfer is the same as the data originated by 
the source.

(Daily) Detail 
Report

A report that the JBC or eScan prints when the polls at an Early Voting site are 
suspended. This report identifies the number of ballots cast per precinct.

Daily (Access 
Code) Summary

A summary on the JBC “Suspend Report” and “Daily Detail Report” that lists the 
Access Codes issued, voted, expired, and canceled for only the current day of 
Early Voting.

Daisy Chain Items connected in a series. The eSlates are daisy chained, one to another, 
with one plugging into the JBC.

Damaged Contest In Ballot Now, a mark requiring resolution because the option box has been 
erased or partially erased (damaged). A damaged contest may be resolved for 
voter intent or confirmed. If confirmed, a damaged contest will register as no 
choice for that selection. This may result in fewer selections than allowed for 
that contest; i.e., an undervote.

Database A storage point for information (data).

Demo Card An ATA memory card that contains both ballot and audio data for use in a 
Demonstration eSlate.

Demonstration 
eSlate (Demo)

An eSlate set up for voter education purposes, to allow voters to practice using 
the eSlate buttons and interface (including headphones and adaptive devices, if 
desired) on a functioning unit that cannot record votes. A Demonstration eSlate 
does not require a JBC in order to display ballots because it uses a special ATA 
memory card that contains both ballot and audio data. Demonstration eSlates 
are also known as “demo units.”

Digital Signature An encrypted digital code appended to data, making it possible to require 
authentication before allowing access to that data. 

Direct Record 
Electronic (DRE)

The election industry term for an electronic machine at which a voter can view, 
vote, and cast a ballot.

Term: Definition:
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Disabled Access 
Unit™ (DAU)

An eSlate that includes accessory components so that disabled persons can 
vote independently and privately. DAU eSlates include a module that accepts 
audio cards so that voters can listen to the ballot with headphones. DAU 
eSlates also have jacks for tactile input switches or “sip and puff” devices so 
that voters with limited mobility have alternatives to the SELECT wheel.

District A selection of precincts and/or split precincts that determine a voting group.

Duplicate Ballot During scanning, if serial numbers were printed on ballots, Ballot Now will 
search the database for an identical ballot serial number every time a ballot is 
scanned, and disallow the ballot if it is a duplicate.

Duplex Two-sided. In Ballot Now ballots are printed and scanned on both sides of the 
ballot sheet. The eScan scans both sides of the ballot sheet.

Early Voting In the Hart Voting System, the term for votes cast in-person prior to Election 
Day. Nomenclature for “Early Voting” varies from state to state in the U.S.A. 
(Absentee In-Person, Absentee Walk-In, etc.). Totals are not available from the 
polling place during the Early Voting period (i.e., no “Tally” report available).

Early Voting 
Retrievable Ballot

Ballots cast on the eSlate at Early Voting polling places that can be retrieved by 
Ballot Code from the Tally tabulation application by election officials. The Ballot 
Code is printed on the Retrieval Stub for an Early Voting retrievable ballot. A 
checkbox in BOSS must be selected in order to identify eSlate ballots cast 
during Early Voting as retrievable.

eCM eSlate Cryptographic Module; a highly secure peripheral USB device provided 
by Hart InterCivic. The eCM contains the signing key, the key ID, and the eCM 
PIN required to perform certain functions in the Hart Voting System 
applications.

eCM Manager The Hart InterCivic software application that manages approved security 
functions for use in the Hart Voting System. eCM Manager is used to create a 
signing key, and then write the signing key, key ID and eCM PIN to the eSlate 
Cryptographic Module (eCM).

eCM PIN eSlate Cryptographic Module Personal Identification Number; a password 
selected by the jurisdiction system administrator before any signing keys are 
written. This PIN is used to access functions requiring the eCM.

EDX Election Definition XML (eXtensible markup language); a format for election 
information data exchange.

Election 
Assistance 
Commission 
(EAC)

An independent federal commission that serves as a national clearinghouse 
and resource for the compilation of information and review of procedures with 
respect to the administration of federal elections.

Election ID An election identification code that is unique for every election. The election ID 
is used internally by the software applications.

Term: Definition:
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Election 
Identification 
Report

A report that the JBC or eScan prints when the polling place ID is selected. The 
report contains the current date and time, jurisdiction name, election name, 
election date, polling place, and number of precincts enabled for the polling 
place. For Election Day, shows the name of all precincts enabled for the polling 
place.

Election 
Management 
System (EMS)

A set of processing functions and databases within a Voting System that define, 
develop and maintain election databases; perform election definition and setup 
functions; format ballots; count votes; consolidate and report results; and 
maintain audit trails.

Encryption Any procedure used in cryptography to convert plaintext into ciphertext 
(encrypted message) in order to prevent any but the intended recipient from 
reading that data.

eScan™ Hart InterCivic’s precinct paper ballot scanning device. A  paper ballot printed 
from Ballot Now can be scanned and recorded on this device.

eSlate® Hart InterCivic’s direct record electronic (DRE) voting device. An electronic 
ballot can be viewed, voted, and recorded on this device. 

Event In SERVO, a specific backup of a set of devices in SERVO. An Election MBB is 
required to create an Event. Each Event relates directly to either an Election or 
a Test Election.

FEC Federal Election Commission, an independent federal regulatory agency. 
Voting systems regulation formerly assigned to this body have been transferred 
to the Elections Assistance Commission (EAC).

Finalized In BOSS, the database status that prevents further data modification and 
writing of MBBs to make it available to Tally. In Tally, the database status that 
prevents further reading of votes from MBBs into Tally.

FireWire A personal computer and digital video serial bus interface standard offering 
high-speed communications and isochronous real-time data services. FireWire 
(also known as i.Link or IEEE 1394) can be considered a successor technology 
to the SCSI Parallel Interface. FireWire is capable of transfer speeds of up to 
400 megabits per second.

Firmware Computer programs (software) stored in read-only memory (ROM) devices 
embedded in the system and not capable of being altered during system 
operation. For purposes of applying the Standards, firmware is considered a 
form of software.

Flash Memory Reprogrammable, read only memory that is used in PC cards or MBBs. Flash 
Memory does not require continuous electric power to operate. It is a system 
that can store more data and work faster than a traditional floppy disk.

Fractional 
Cumulative
Voting

A voter selects at least one candidate in a contest that allows votes for multiple 
options, but selects fewer than the number of options allowed. The unvoted 
options that were allowable are distributed equally to the voted options.

Functionality Test Testing of hardware functionality (e.g., testing to see that an eSlate button 
responds when pressed).

Term: Definition:
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Fusion™ A supplemental Hart Voting System software application used to integrate data, 
as from Tally and another voting system, and/or to provide custom reporting.

Hart Voting 
System

The full suite of Hart InterCivic’s election software and hardware products, 
covering everything from ballot creation to tabulation. Includes: BOSS, Ballot 
Now, eScan, JBC, eSlate, Rally, Tally, utility products, and SERVO. Previously 
referred to as the ‘eSlate Electronic Voting System.’

Hash Algorithm that maps a bit string of arbitrary length to a fixed-length bit string. 
Approved hash functions satisfy the following properties: (a) it is 
computationally infeasible to find any input that maps to any prespecified 
output, and (b) it is computationally infeasible to find any two distinct inputs that 
map to the same output.

HAVA The Help America Vote Act, signed into law October, 2002. HAVA intends to 
assist states in the administration of federal elections and establishes 
“minimum standards for states and units of local governments with the 
responsibility for the administration of federal elections.”

Incomplete Ballot A multi-sheet ballot being scanned in a scan batch that has its first sheet, but is 
missing following sheets.

Infusion™ A supplemental Hart Voting System software utility used to extract data, as from 
another voting system or voter registration system, and/or to provide ballot data 
formatted for import into BOSS.

Initialized Report A report printed from the JBC and eScan any time the device is powered on. 
This report shows a timestamp, firmware version, and diagnostic test result. A 
self-diagnostic test is run on the system, and the result is indicated as 
“**PASS**” on the report.

Judge’s Booth 
Controller™
(JBC)

The control unit of the eSlate system, through which a poll worker distributes 
electronic ballots to the eSlate and DAU eSlate.

Jurisdiction A precinct or group of precincts managed by a single organization.

Key GUID Key Globally Unique Identifier. A unique, system-generated value assigned to 
each signing key in the eCM Manager.

Key ID A user-selected identification number that prompts the eCM Manager 
application to generate a new 128-bit encrypted signing key. Allowed values are 
from 1 to 99.

Locked Ballot In Ballot Now, a ballot that is currently checked out in the resolve process for 
editing by a user.

Logic and 
Accuracy Test 
(L & A or LAT)

In the context of an election, a test to check the accuracy of a piece of voting 
equipment. An LAT is accomplished by feeding test ballots for which the results 
are already known (i.e., a “test deck”) through the ballot counting system and 
comparing the results with the expected results. If an error occurs (i.e., the 
actual test deck count does not match the expected count), then the problem is 
investigated and corrected, and the test is repeated.

Term: Definition:
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MBB, Election An MBB used to collect votes for an election. The Election MBB can only 
contain information from Election ballots.

MBB, Test An MBB used for test purposes when validating the eSlate system before an 
election. The Test MBB can only contain information from Test ballots.

Mobile Ballot 
Box™ (MBB)

A PC card that holds all of the ballot information for the Hart Voting System. An 
MBB is placed in the JBC unit, the eScan device, and/or in the Ballot Now 
computer. Cast Vote Records are also stored on MBBs, which are read into 
Tally. Audio is not stored on an MBB.

Network 
Configuration 
Report

A report printed on the JBC after booths are assigned. The report contains the 
serial number, software version, PUB count, and PVT count for the JBC and 
each eSlate unit.

Non-partisan 
Office

An elected office for which candidates run independent of political party 
affiliation.

Orphan Ballot A multi-sheet ballot being scanned in a scan batch that has missing leading 
sheets.

Overvote The generally prohibited practice of voting for more than the allotted number of 
options for a given contest. 
On the eSlate it is not possible to overvote.

Party A political party, for example Democratic or Republican.

PC Card An information storage device that is about the size of a credit card. Similar to a 
USB memory stick. It is also called a “PCMCIA” card. In the Hart Voting System 
it is called a Mobile Ballot Box (MBB), an audio card, or a demo card.

Persistence A property of a programming language where created objects and variables 
continue to exist and retain their values between runs of the program.

Polling Place The area within the polling location where voters cast ballots. 
Often a single polling place supports several precincts.

Polls Closed 
Report

Report printed by the JBC, VBO and/or eScan when the polls are closed. This 
report includes a timestamp indicating the date and time printed.

Polls Open Report Report printed by the JBC, VBO and/or eScan when the polls are opened. This 
report includes a timestamp indicating the date and time printed.

Poll Worker 
Button

A button, located on the back panel of the eScan device, used to access poll 
worker and administrator functions.

Precinct A jurisdiction subdivision for election purposes.

Precinct Voting 
System
(PVS)

A legacy term for those components of the Hart Voting System that are used for 
election activities at individual polling places. 

Provisional Ballot A ballot provided to individuals who claim they are eligible to vote but whose 
eligibility cannot be confirmed when they present themselves to vote. Once 
voted, such ballots are not included in the tabulation until after the voter’s 
eligibility is confirmed.

Term: Definition:
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Provisional Ballot 
Stub

A report that prints below the Access Code when a provisional ballot is 
requested during the “Add Voter” procedure on the JBC. This stub includes the 
Ballot Code used for ballot retrieval during the tabulation process. The stub 
must be separated from the Access Code and kept for ballot tracking purposes 
for this unique type of ballot.

Provisional 
Parsing

The process of selectively reporting on a provisional ballot only those contests 
in which a provisional voter is eligible to vote, based on his/her precinct of 
residence. Provisional parsing becomes necessary when the provisional voter 
has cast a ballot outside of his/her correct precinct, and the voted ballot style 
includes contests for which the voter is not eligible to vote. When the Tally 
software application is installed, users have the option to enable a provisional 
parsing interface. If enabled, once the Tally application has selectively identified 
(i.e., “parsed”) those contests on a provisional ballot for which voted options 
shall be reported, election officials can choose how to report results: cast votes 
may be associated with the original precinct in which the provisional ballot was 
actually cast, or they may be reassigned to the voter’s correct precinct. 

Provisional Voter A voter whose eligibility is yet to be determined at a given polling place. A 
provisional voter is allowed to vote on a “provisional ballot” under conditions set 
by state election law. Because the voter is “provisional”, his/her ballot must be 
retrievable by election officials under certain conditions that vary from state to 
state.

PUB (Public) 
Count

Also called the “ballot counter”. A six-digit number, shown on the JBC and 
eScan configuration reports and Polls Open screen, and in the Ballot Now 
window, that indicates how many votes have been counted, and CVRs 
recorded, on that machine for the current election. The public count of a device 
is reset to “zero” during warehouse operations between elections.

PVT (Private) 
Count

A six-digit number, shown on the JBC and eScan configuration reports and 
Polls Open screen, and in the Ballot Now window, that indicates how many 
ballots have been cast on that machine in its lifetime. CVRs are not associated 
with the private counter. The private counter cannot be zeroed.

Rally™ The Hart Voting System application that reads, stores, and transfers CVRs via 
local area network or modem connection to a PC running the Tally application.

Replacement 
Ballot

A ballot that is designated by the election authority to be a replacement for a 
spoiled ballot.

Resolution The Ballot Now task of assigning the voter’s intent to votes on ballots that 
contain an undervoted contest, an overvoted contest, or a contest with a 
selected write-in. Resolution may also exclude a completely blank ballot or a 
damaged ballot.

Sample Ballot A ballot printed as a sample of the real election ballot. Sample ballots contain a 
special barcode which prevents them from being included as a CVR in an MBB.

Scan Batch A group of ballot sheets to be scanned. Each scan batch has certain number of 
sheets. Ballot Now assigns and prints a sequence number when the ballots are 
printed. The user can assign comments to a scan batch in the Scan Ballots 
window prior to scanning the batch of ballots.

Term: Definition:
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Select Wheel The rotary wheel on the eSlate and DAU eSlate that allows a voter to navigate 
the ballot and highlight choices by turning the wheel.

Serial Number A barcode and/or human-readable number placed on the ballot stub and/or the 
sheets of a ballot that uniquely identifies the ballot in order to prevent duplicate 
scanning of paper ballots.

SERVO™ The eSlate application used as a System for Election Record Verification and 
Operations. This application is used for polling place equipment cast vote 
record backup, recovery, recount, and resetting.

Sheet In reference to Ballot Now paper ballots, one piece of paper printed on both 
sides, i.e., duplex. Ballot Now ballots can consist of no more than 9 sheets.

Signing Key A true 128-bit random number used to cryptographically protect data, making it 
possible to require authentication before allowing access to the data. In the Hart 
Voting System, the signing key is written to the eCM, JBCs, eScans, and MBBs.

Sip-and-Puff A voter’s personal input device that connects to the DAU eSlate in the disabled 
access jack. This enables disabled voters with extremely limited mobility to vote 
with a mouth-controlled device.

Split Precinct The smallest division of a precinct for election purposes.

Spoiled Ballot A ballot that has been rendered invalid by a voter who is still present at the 
polling place, making it necessary to give the voter a new ballot. With the 
eSlate, a ballot is spoiled if the voter gets the wrong ballot style, the wrong 
language, or is not on the DAU eSlate but needs to be.

SSL Secure Sockets Layer; a protocol developed by Netscape for transmitting 
private documents via the Internet. SSL works by using a private key to encrypt 
data that is transferred over the SSL connection.

Straight Party 
Voting

A voting method that presents a contest that allows selection of a single political 
party in order to automatically select candidates of that party in contests that 
allow straight party voting.

Suspend Report A JBC or eScan report that automatically prints when polls are suspended in 
Early Voting. For the JBC, the report lists the PUB count and PVT count of the 
JBC and eSlate units, a Daily (Access Code) Summary, and a Cumulative 
(Access Code) Summary, as well as a timestamp.

Tactile Input 
Switches

Also called “dual mode switches,” “jelly switches,” or “buddy buttons,” these red 
and green “paddles” enable voters with disabilities to vote without using the 
SELECT wheel and ENTER button on the eSlate. Voters without fine motor 
control may use these. The red tactile input switch allows voters to navigate 
through the ballot, similar to turning the SELECT wheel in a clockwise direction. 
The green switch is similar to pressing the ENTER button.

Tally™ The Hart Voting System tabulation software. After an election, the Tally software 
counts the votes on the MBB(s) and produces reports on those cast votes.

Term: Definition:
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Tally Report Tape An Election Day report that may be printed on a JBC or eScan after polls are 
closed. It includes the date, time, precinct, a tally of votes for each contest, and 
an Access Code or ballot summary. BOSS includes a setting for allowing, or 
disallowing, this report to be printed from the JBC or eScan after close of polls 
on Election Day.

TRANS Translation, Recording, and Audio Normalization System; an eSlate application 
for translating multi-language ballot text and for recording all audio (including 
English) to be imported into the BOSS database.

Undervote The practice of voting for less than the total number of election contests listed 
on the ballot, or of voting for less than the number of options allotted for a given 
contest. 

UPS Uninterruptible Power Supply.

USB Universal Serial Bus; an external peripheral interface standard for 
communication between a computer and other devices. In the Hart Voting 
System, an eCM connects to a USB port.

VBO Verifiable Ballot Option; the Hart Voting System VVPAT (Voter-Verified Paper 
Audit Trail) device that can be connected to the eSlate or Demonstration eSlate 
inside the voting booth in order to print a paper record of each ballot cast.

Voter Registration 
Computer

An electronic poll book sometimes known as a “thin client” or “VR Computer.”

VVPAT Voter-Verified Paper Audit Trail; Implemented in the Hart Voting System by the 
VBO (Verifiable Ballot Option) device.

WAV file A file format (.wav) used for storing digital audio. TRANS audio is stored in .wav 
file format.

Write-in A name of a candidate entered by the voter in order to vote for a candidate that 
is not listed on the ballot.

Write-in, certified A candidate that has been certified by the election authority as being a valid 
write-in candidate for the election.

Write-in Voting A means to cast a vote for an individual not listed on the ballot.

XLIFF XML Localization Interchange File Format. A file type (.xlf) used by BOSS and 
TRANS for language text translation.

XML eXtensible Markup Language. A structured, extensible, text-based data 
definition and data exchange format. TRANS uses an .xml file as a manifest, or 
index, to associated audio .wav files. 

Zero Tape Report A JBC or eScan report that prints out when polls are opened on the first day of 
Early Voting and on Election Day. This report lists the timestamp, the number of 
precincts at the polling place, the contests and candidates on the ballot, and 
verifies that the number of votes for each candidate or option is zero.

Term: Definition:



6300-002 62C BOSS Training Manual

© Hart InterCivic, Inc. Appendix B: Information, Confirmation, Error, and Warning Messages   Page 107

Appendix B: Information, Confirmation, Error, and Warning Messages

Type of 
Message: Explanation: Example:

Information Informs about an 
operation
Includes an 
information icon
Includes an OK 
button

Confirmation Asks user to confirm 
an action, particularly 
when the action 
cannot be reversed
May include text from 
the command 
performed
Includes a question 
mark icon
User responds with 
Yes or No

Error First statement in 
error identifies the 
problem
Second statement 
may inform user of 
required action
Includes an error icon
Includes an OK 
button

Warning Appears when the 
user must double-
check a command
May include text from 
the command 
performed
Includes a warning 
icon
Includes an OK 
button
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Notes:
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Appendix C: Hart Voting System Software User Tips

The following apply to ALL Hart Voting System programs.

Software Password, Certificate, and PIN Tips
Best Practices

Do not give out an administrator password, applicable either to the PC where the Hart Voting System 
software is housed, or to a Hart Voting System application itself.
Change every user ID, password, certificate, eCM key ID, signing key, and PIN(s) during PC 
acceptance and at regular intervals and in accordance with federal, state, and local guidelines.
The user currently logged in should stay at the computer while running the application and exit the 
application if s/he steps away from the PC.

Avoid Using

Any password you have used before
Any string of three characters repeated or reversed
Any character repeated more than twice
Your name or your initials
The computer or application user ID
The names of relatives, birthdays, phone numbers or the company name
The number for this year, last year or next year, or the three-character abbreviations for the months
Telephone number or car license plate numbers

Do Use

A combination of upper and lowercase letters
A password that is at least 6 - 12 characters long
A new password for every user at regularly scheduled intervals (e.g., annually or quarterly)
Random characters users will remember

Tips for a Secure Password, Certificate, or PIN

Use the first letters of the words in a memorable phrase.
Use a meaningless but easy-to-remember phrase.
Insert numbers into the phrase.
Note the password, certificate information, and/or eCM PIN, in a private and secure location.

Computer Security
Computers running Hart InterCivic software should be kept in locked spaces with limited access. 
Password-protected screen savers or other similar security measures should be applied.
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Software Features
Whichever button is shadowed/dotted inside a window is the button selected for activation with the 
keyboard Enter key.
Whichever character on a menu or button is underlined indicates that the function may be activated 
with the Alt key and that character. 

In a menu, an arrow facing to the right opens a pop-up menu, offering more choices.

In a dialog box, the arrow facing down opens a list box, offering more choices.

Per application, to view the version release number (N.N.N), go to the Help menu and click About.

The following tips apply to specific software programs:
BOSS, Ballot Now, Tally, and SERVO: To highlight/select a list of items (e.g., precincts) that are 
consecutive, use Shift + Click.
1. Click the first item once. 
2. Hold down the Shift key. 
3. Click the last item once. 
4. Release the Shift key.

BOSS, Ballot Now, Tally, and SERVO: To highlight/select a list of items (e.g., precincts) that are not 
all consecutive, use Ctrl + Click. 
1. Click the first item.
2. Hold down the Ctrl key.
3. Continue to click items, holding down the Ctrl key, until you have selected all targeted items.
4. Release the Ctrl key.
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BOSS Copy and Paste:

1. Only copy and paste from “flat” text files that were originally written in Arial Unicode, and that are 
opened from within Notepad. When using copy/paste, there is a possibility that unwanted 
characters can be pasted into BOSS.

2. Select the item(s) you wish to copy from the source document. 
(To select, click and drag over the item to highlight it.)

3. Press Ctrl and then C (the shortcut key for copy).
4. Return to BOSS.
5. Make certain the cursor is blinking in the field you wish to paste into and press Ctrl + V to paste.
• You can copy and paste from one BOSS field to another, in most windows, by using Ctrl + a 

shortcut key (C,X,V).
BOSS arrow buttons: 

BOSS: Double-clicking on a selection also moves that selection from one column to another.
BOSS: Once the ballot is generated, the current database cannot be edited or changed. Audio is not 
available for recording after generating a ballot. Once the MBBs are written, the only action available 
is to write additional MBBs. Once the BOSS database is finalized for Tally, no actions are available in 
that database.

  See:
  See:“Appendix D: Backing Up Election Databases” on page 113.

BOSS Right-click Functionality:
• The right-click mouse function is available for standard options in many BOSS fields.
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• In addition, graphics options are available via the right-click function on the Ballot Preview tab of 
the Ballot Generation/Preview window.

BOSS Pipe Character Functionality:
• Pipe characters (|) can be used to force a line of text to the next row. This is useful when 

formatting ballots in BOSS. 
• The pipe character can be inserted using Shift and the backslash (\) key on the keyboard. The 

backslash is just above the Enter key on the right side of the keyboard.

• A single pipe character (e.g., “text|text”) will have the effect of a hard return. The text after the 
pipe will start on a new line.

• There is no need for a space either before or after the pipe character, unless two hard returns are 
the desired outcome (e.g., “text| |text” would result in a blank line between the two words).

• A double pipe character without a space between pipes (e.g., “text||text”) will have the effect of 
hiding the text after the second pipe on all ballots.
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Appendix D: Backing Up Election Databases

What Data to Back Up

The following database folders should be backed up to CD1:

eCM Manager; *.eCM file created with the Save File function
BOSS; Numbered folder with BossData.db and BossData.cfg files
Ballot Now Test; Numbered folder with the election I.D. followed by a “T” (e.g., 023T), in addition to 
the BNsecurity.db and BNsecurity.cfg files in the “Ballot Now” folder
Ballot Now Election; Numbered folder with the election I.D. (e.g., 023), in addition to the 
BNsecurity.db and BNsecurity.cfg files in the “Ballot Now” folder
Rally;  “Database” folder with the Mbbtrans.db and Mbbtrans.cfg files
Tally Test; Numbered folder with the TallyData.db and TallyData.cfg files
Tally Election; Numbered folder with the TallyData.db and TallyData.cfg files
SERVO; “Database” folder with the ServoData.db and ServoData.cfg files.

Locations of Election Database Folders for Backup:

eCM Manager; after selecting Save File, use standard Windows navigation to navigate to a folder 
named for the election and to name the .eCM file.
BOSS; C:\boss\Database\YearMonthDay-HourMinuteSecond (12 digits)
Ballot Now; C:\Program Files\Hart Intercivic\Ballot Now\### (three-digit Election I.D.)
• C:\Program Files\Hart Intercivic\Ballot Now\BNsecurity.db
• C:\Program Files\Hart Intercivic\Ballot Now\BNsecurity.cfg
Rally; C:\Program Files\Hart InterCivic\Rally\Database
Tally; C:\Program Files\Hart InterCivic\Tally\Database\YearMonthDay-HourMinuteSecond (12 digits)
SERVO; C:\Program Files\Hart InterCivic\SERVO\Database

Naming conventions for folders and CD files:

Name each application’s backup folder with the application, election, type of election, and date of 
election. (Example: BOSSgeneral_11.02.04)
Name the CD within the character limits for the CD creator application. The jurisdiction, election, and 
election date should be included. (Example: Smith_gen11.2.04)

How and When to Back Up Data

BOSS, Tally, and Rally include backup or archive functions within the user interface. An administrator-
level user may use this function to back up the database and configuration files to a user-defined 
directory on the PC. Database and configuration files should always be saved to folders named for the 
election, the time and date, and the status of the database.

All application databases can be backed up by saving the folders indicated in the “Locations of Election 
Databases” section to a user-defined directory on the PC and/or directly to CD. These folders should 
always be saved to a directory (folder) named for the election, the time and date, and the status of the 
database.

Back up the .eCM file:
• Immediately after creating eCMs for the election.
Back up the numbered BOSS database folder (or use the Archive function in BOSS):
• Immediately before exporting text for translation
• After importing translated text and audio
• After completing all proofreading and before generating the ballot

1. If a database is too large for backup to CD, another medium will be required.
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• After generating the ballot and writing media, but before finalizing the database
• After finalizing the database.
Back up the numbered Ballot Now database folder and BNsecurity.db and BNsecurity.cfg files:
• After closing the election in Ballot Now, at minimum.
Back up the numbered Tally database folder (or use the Backup function in Tally):
• After each instance of creating printed and exported reports for public use (e.g., media outlets)
• After processing absentee by-mail MBBs on Election Day
• After processing Early Voting MBBs
• After each instance of creating printed and exported reports for public use (e.g., media outlets) 

on Election Day
• After processing absentee by-mail late mail MBBs after Election Day
• Before resolving write-in votes
• Before resolving provisional ballots
• Before finalizing
• After finalizing
• Immediately after Canvassing.
Back up each Rally station “Database” folder (or use the Archive function in Rally):
• After processing all MBBs and printing and exporting final reports and before resetting the Rally 

database (including before resetting the Rally database as an emergency procedure).
Back up the SERVO “Database” folder:
• After inventorying equipment with SERVO pre-election
• After backing up equipment post-election
• On the “master” SERVO PC after combining events into one “master” event for an election, if 

applicable.

Backing up to CD

In order to back up to a CD, use the CD creator application supplied with the Hart InterCivic PCs. Refer 
to the online help for the specific steps for creating a CD.

Hart InterCivic suggests using a CD-R rather than a CD-RW. A CD-R is a one-time use—you can only 
write to it once, and then you can only read off of it. A CD-RW is readable/writable, and can be used 
multiple times like a floppy disk—you can read and write to it as often as you want. CD-Rs are 
inexpensive, and the data on the CD itself cannot be changed. This makes the CD-R option a good 
media for backing up data. 

After creating a CD, always navigate to the CD drive and verify that the CD contains all of the data 
intended for backup.
Label the CD with the Jurisdiction, Election Title, Date, and eSlate application.
File the CD in a secure location.
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Appendix E: Accent Marks for Spanish Language Text
To enter diacritical marks into TRANS or BOSS fields, press and hold the ALT key then press Zero + the 
number(s) corresponding to the character you wish to insert. Use only the PC numeric keypad for 
number entry. The numbers along the top of the keyboard will not work.
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Notes:
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Appendix F: Copying Forward a BOSS Database
Follow these procedures in order to create a copy of an existing database. Copying forward is useful 
when data changes must be made after a database has been generated or finalized. When copying 
forward, all data in the original database is retained, available ballot templates are retained (i.e., if 
special templates were installed for the original database, they will carry over), and the newly created 
database is in an open state.

1. Go to the File menu and click Open Database.

2. In the Open Database window, click Add Database.

3. In the Create Database window, select the existing database targeted to copy forward.

4. Enter a new database description.
> After creating a database the description appears in the Database Description field of the 

Open Database window.
> This does not name the actual file. The name of the file is “BossData.db”. The entire path to 

this file appears in the Database Filepath field of the Open Database window.
> BOSS allows multiple databases with identical descriptions.
> Use a standard naming convention for databases, including a description of the database, the 

sequence number, the election name or type, and the date.

  See:
  See:Suggested naming conventions in “Database Management” on page 9.

5. Click OK and proceed to open the new database.
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Appendix G: Updating BOSS Templates
Follow these procedures in order to apply new BOSS ballot templates delivered from Hart InterCivic in 
the form of a new default BOSS database.

1. Open C:\BOSS\database, find the BOSSDATA.db and BossData.cfg files, and copy them.

2. Create a new folder on your PC desktop, name it Sys 6.2 Orig BOSS Default db, and paste the 
two BOSS files into it.

3. Save the Sys 6.2 Orig BOSS Default db folder to CD and delete it from your desktop.
4. Create a new folder on your PC desktop and name it MODIFIED.
5. Copy the modified BOSSDATA.db and BossData.cfg files you got from the ftp site or CD and 

place them into the MODIFIED folder on your desktop.
6. Copy the BOSSDATA.db and BossData.cfg files into C:\BOSS\database. Click Yes to replace the 

current files.
7. Delete the MODIFIED folder and empty the recycle bin on your PC.
8. Delete the bossdata.log file from the C:\BOSS\database folder.

  Note:
Do not delete bosssecurity.log.

9. Create a new folder on your PC desktop and name it EXPORT.
10. Open BOSS, open the smallest BOSS database on your system, and export all files to this 

EXPORT folder.
11. In BOSS, go to the File menu and click Open Database.
12. Click Add Database, name the new database Test of Mod Default, open it, and import the data 

files from the EXPORT folder you created. If you see the message “Records currently exist for 
the selected element”, click Replace. If you see a message relating to FASTLOAD, click Yes.

13. Open the Test of Mod Default database, go to the Ballot Formats menu, and click Ballot 
Templates. The bottom of the template list (eSlate or Ballot Now, as appropriate) contains the 
new modified template(s). Remember to choose a paper size for your new Ballot Now template.

14. Select the new template(s) and generate the ballot for preview. Review the ballot styles to ensure 
they have the new format intended from the modified template(s).

15. Reject the ballot, delete the Test of Mod Default database if desired, and close BOSS.
16. In order to apply these templates to a database created prior to installing the new default 

database:
a.  Open the preexisting database.
b.  Export all files and close the database.
c.  Open a new database in BOSS, copying from the default database.
d.  Import the files into the new database. 
e.  Proofread all data in the new database.
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Appendix H: California Rotation and BOSS

Introduction
Purpose

The purpose of this appendix is to clarify California rotation requirements and how they are applied in 
BOSS. It is not meant to teach California rotation requirements, but to identify the application of those 
requirements in the functionality of BOSS.

Overview

California rotation is the application of a set of rules against a set of data. First, you must understand 
district types and how these types associate with each other. Then the rules that apply for each contest 
type (State-Wide, BOE, Congressional, etc.) become easier to understand.

This appendix discusses the following:
District types and how they are associated with one another
California rotation rules and how they apply to district types
How to set up California rotation in BOSS

California Alphabets

The are two different alphabets by which the candidate names are ordered:
Secretary of State (SOS) Random Alphabet
• Drawn by the Secretary of State at 11:00 a.m. on the 82nd day prior to the election
• Used for all offices except multi-county state legislative offices
County Random Alphabet
• Drawn by each county in which there are multi-county legislative districts at 11:00 a.m. on the 

82nd day prior to the election
• Used only for multi-county state legislative offices

District Types 
State Assembly Districts

California is separated into individual, discrete districts called State Assembly Districts, each denoting 
the district of an elected Assemblyman. For purposes of candidate rotation only, there may be several 
Assembly Districts within each Board of Equalization, Congressional, County-Wide, and State-Wide 
district.

State Assembly Districts that reside outside the election jurisdiction (e.g., Orange County) but still must 
be considered for purposes of rotation are called Multi-Jurisdiction Assembly Districts in BOSS.

Every Assembly District is numbered (e.g., 47th Assembly District, 68th Assembly District, etc.). This 
number is important because it is the order in which rotation is implemented. Therefore, in BOSS, this 
number is known as the “rank” of the Assembly District.

Candidates for State Assembly contests do not rotate.

State-Wide Districts

The State-Wide District is the entire State of California. State-wide contests are contests that appear in 
every ballot in California. Examples are Governor and Lieutenant Governor.
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Board of Equalization

Board of Equalization (BOE) Districts are districts of elected Board of Equalization members. BOE 
Districts contain State Assembly Districts, some of which may not lie within the election jurisdiction.  
All State Assembly Districts still must be considered for purposes of rotation.

Congressional Districts

Congressional Districts are districts of elected Federal Congressional members. Congressional Districts 
contain State Assembly Districts that may or may not reside within the election jurisdiction. In other 
words, Assembly Districts make up Congressional Districts which may encompass an area outside the 
election jurisdiction. Only those Assembly Districts within that Congressional District must be considered 
for purposes of rotation.

County-Wide Districts

The County-Wide District is the district encompassing the entire county, which is usually the area 
representing the election jurisdiction. The county-wide contests, such as County Commissioner, are 
applied within the County-Wide District.

The County-Wide District rotates either by the State Assembly Districts therein (if there are at least five 
of them within the county) or by the Supervisorial Districts (if there are less than five State Assembly 
Districts within the county).

Supervisorial Districts

Supervisorial Districts represent the areas for Supervisorial contests. There are five Supervisorial 
Districts in each county. These contests sometimes rotate their candidates (in San Mateo County, for 
example), and in that case must be identified in BOSS as State Assembly Districts or State Assembly 
Districts (Multi-Jurisdiction) so you can associate them with subdistricts.

State Senate Districts

State Senate Districts represent districts of elected State Senators and do not affect the rotation of any 
contest.

Candidates for State Senator contests do not rotate. This type exists in BOSS only to give you a way to 
distinguish them separately.

California Rotation Requirements
General

Rotation and Random Alphabet – The order in which the candidates appear after having been placed in 
the Secretary of State’s (SOS) Random Alphabet is the 1st rotation. For the 2nd rotation, drop the top 
candidate to the bottom of the list and move all other candidates up. Continue this process through each 
rotation. The same process is followed in multi-county state senate and state assembly contests, which 
use county random alphabets.

Rotation Indices and Rotation Rank – The contest rotation index in contests that rotate is determined by 
rank order of the Assembly District within that contest district type, with the “fewer than five” 
Supervisorial District exception. BOSS computes indices based on district ranks and district-to-district 
assignments input via the California Rotation Wizard.
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Candidate Order in State-Wide Contests

SOS Random Alphabet

State-wide contests are contests that appear in every ballot in California. Examples are Governor and 
Lieutenant Governor.

Explicit Rotation Index based on Assembly District: The State of California requires that state-wide 
contests rotate their candidates by Assembly District rank. The original order appears in Assembly 
District Number 1. Rotations continue throughout all Assembly Districts in these contests.

For example, the Governor’s contest in a precinct within the 46th State Assembly District rotates its 
candidates to the 46th order of rotation. 

Candidate Order in Board of Equalization (BOE)

SOS Random Alphabet

Derived Rotation Index based on Rank of Assembly District: Rotate by Assembly District within the BOE, 
using the rank of the Assembly District to order the Assembly Districts within the BOE. The original order 
appears in the lowest numbered Assembly District in the contest. Rotations continue throughout all 
Assembly Districts in that contest.

For example, if an Equalization District has the 26th, 30th, 33rd, and 35th Assembly Districts, but only 
the 26th, 30th, and 35th Assembly Districts are in the county, that Equalization District’s candidates will 
appear in the 1st, 2nd, and 4th rotations. The 3rd rotation will be used in the county(ies) in which the 
33rd Assembly District lies. Thus, the necessity for keeping track of those Assembly Districts that are 
“out of jurisdiction” (multi-jurisdiction) because they are used to calculate the order of rotation. 

If there is more than one Equalization District, each must rotate individually.

Candidate Order in Congressional (Federal) Contests

SOS Random Alphabet

Derived Rotation Index based on Rank of Assembly District: Rotate by Assembly District within 
Congressional District, using the rank of the Assembly District to order the Assembly Districts within the 
Congressional District. The original order appears in the lowest numbered Assembly District in the 
contest. Rotations continue throughout all Assembly Districts in that contest. 

For example, if a Congressional District has the 13th, 14th, 18th, and 22nd Assembly Districts, but only 
the 13th and 22nd Assembly Districts are in the county, the candidates in that Congressional District will 
appear in the 1st and 4th rotations. The 2nd and 3rd rotations will be used in the county(ies) in which the 
14th and 18th Assembly Districts lie.

If there is more than one Congressional District, each must rotate individually.

Candidate Order in County-Wide Contests

SOS Random Alphabet

Derived Rotation Index based on Rank of Assembly District: If there are five or more State Assembly 
Districts within the county, the county-wide contests rotate by Assembly District within the County-Wide 
District.
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For example, suppose the County Commissioner contest is in all seven Assembly Districts (say 
Assembly Districts 61-67 inclusive) in the county. Ordering by Assembly District rank, the candidates 
rotate by the following order: 61st AD = 1, 62nd AD = 2, 63rd AD = 3 and so on.

Explicit Rotation Index based on Supervisorial District: If there are fewer than five State Assembly 
Districts within the county, candidates rotate by Supervisorial District rank within the County-Wide 
District.

For example, County Commissioner would rotate its candidates by Supervisorial District as follows: 1st 
Supervisorial District = 1, 2nd Supervisorial District = 2, 3rd Supervisorial District = 3, and so on.

Offices in Which Candidate Names Do Not Rotate

State Legislative Offices (State Senate and State Assembly)

The order of candidate names for the particular race is determined from the SOS random alphabet draw. 
There is no rotation, even though a State Senate District may cover more than one Assembly District. 
For State Assembly contests, since rotation is based on Assembly District, and these are assembly 
races, there is no rotation.

Other offices

County Supervisor (except in some cases, such as San Mateo County)
County Central Committee/County Council (unless elected at-large)
Judicial Offices (if not county-wide, otherwise rotate by Assembly District rank within county)
Municipal/City (unless they have adopted rotation by clusters of precincts)
School District
Special District

California Rotation and BOSS

In BOSS, use the California Rotation Wizard to correctly assign rotation indices to contest/precinct 
relationships in accordance with sections 13100-13121 of the California Elections Code. 

< Back button: Allows you to return to a prior step.
Next >/Finish button: Allows you to move on to the next step. On the last step, this button displays 
the word ‘Finish’ instead of ‘Next >’.
Cancel/Close button: When the button displays ‘Cancel’, the Wizard closes saving no changes. 
When the button displays ‘Close’, the Wizard has completed processing and can be closed.

1. Before you use the Wizard, you must fully define all precincts, districts, contests, district/precinct 
associations, and contest/district associations. Plan for rotation when you create your districts. 
Make a State-Wide District for every contest that appears on every ballot in California; they will 
rotate by State Assembly District. Use your County-Wide District only for those contests that will 
rotate by Supervisorial District. 
 
County-wide contests rotate by Supervisorial District only in those counties that have fewer than 
five State Assembly Districts. If a county has five or more, their candidates rotate by State 
Assembly District rather than Supervisorial District, and in that case you can use a single district 
in BOSS for both state-wide and county-wide contests.

2. Obtain the SOS random alphabet for the election and the county random alphabet. Click the 
Contests tab to create contests, if you haven’t already done so. Go to the Election menu and 
click Active Contests to enter the options (candidate names) in the appropriate order. Use the 
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SOS alphabet for everything except candidates for State Senate and State Assembly, for whom 
you will use the county alphabet.

3. To use the California Rotation Wizard, click the Rotation tab in the Jurisdiction window, select 
the By Precinct radio button, and then click the California Rotation Wizard button. The first 
screen explains the purpose of the Wizard. Click Next >.

4. The next screen allows you to type and rank districts. This is where you will define what the 
district types are and assign ranks to State Assembly and Supervisorial Districts. 
 
The Wizard does not recognize the value of the rankings of the districts, only the quantity of each 
type of district. This means that you must create all of the State Assembly Districts from 1 to the 
highest ranking district in your county, even if you will not assign any precincts to most of them. 
For example, if you have State Assembly Districts 12, 19, and 21, create districts 1 through 21, 
where districts other than 12, 19, and 21 serve as placeholders.

5. In the Wizard, identify the districts according to their types, except for the Supervisorial Districts 
in the event that they must rotate (as in San Mateo County, for example). If they must rotate, 
identify the Supervisorial Districts as State Assembly Districts or State Assembly Districts (Multi-
Jurisdiction) in the Wizard. This will not adversely affect your ballot, but will allow you to 
associate those districts with subdistricts by which to rotate (namely, with the Supervisorial 
Districts themselves). 
 

 
When you have finished typing and ranking districts, click Next >.
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6. The next screen allows you to associate your rotating districts with the subdistricts by which they 
must rotate. For the State-Wide District, associate all your State Assembly Districts, both those 
within your county and the placeholder districts you created in step 2 (but not the Supervisorial 
Districts, even if you have identified them as State Assembly Districts). For the County-Wide 
District, associate all the Supervisorial Districts, if they are the basis of rotation in the county-wide 
contests (see step 1 above). 
  

 
The following associations are allowed:
> Supervisorial Districts are always associated with Assembly Districts
> Assembly Districts are always associated with Board of Equalization and Congressional 

Districts
> Assembly Districts are always associated with County-Wide Districts, unless there are fewer 

than five Assembly Districts within the County-Wide District, in which case, Supervisorial 
Districts are associated with the County-Wide District instead of Assembly Districts 

  Note:
To associate Congressional Districts, you must find out which State Assembly Districts are within 
each Congressional District, whether they are within your county or not. They are the only ones 
through which the candidate names will rotate. For example, if the Congressional District 
contains State Assembly Districts 12, 14, 19 and 21, and only 12, 19 and 21 are within your 
county, you will associate with that Congressional District only State Assembly Districts 12, 14, 
19 and 21, not the entire series from 1 to 21. This will give you the correct rotation for that 
Congressional District across the three State Assembly Districts in your jurisdiction. Create the 
associations for each Congressional District separately in this manner.   
 
When you have finished associating districts, click Next >.

7. The next screen informs you that all data has been gathered and that the wizard is ready to begin 
processing. When you click Finish, the calculation process brings up a BOSS processing 
window that allows you to view the processing being performed.

8. A congratulation screen appears to inform you that processing is finished. Click Close to exit the 
California Rotation Wizard.
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9. To check the accuracy of the rotation, complete the following steps:
9.1  Go to the Election menu and click Write Ballot Media.
9.2  Write an MBB to use with the eSlate system and/or Ballot Now.
9.3  Insert the written MBB into a JBC and view the ballots on an eSlate and/or use the written MBB 

to print ballots in Ballot Now.
9.4  Proofread the ballots. If the ballots contain errors, copy the BOSS database forward and run 

the California Rotation Wizard again. If you must run the wizard again, all types and associa-
tions created previously are preserved.
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Notes:
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Appendix I: BOSS Training Election Outline
Use the following outline to create a simple election database. This training exercise will guide you 
through the various functions available in BOSS.

Image Preparation
• If images are to be used on the ballot, format the images ahead of time before importing into 

target areas

Creating the Database
• Create a database based on (New Database)
• Name the database: <DESCRIPTION # Election Type Date>

Activities in the Jurisdiction Window
• Title: BOSS Training
• Type: General, Special, Closed Primary, or Modified Closed Primary Election
• Ballot Header: Determined by upcoming election type
• Date: Date of class
• State Code: Jurisdiction State
• Jurisdiction Organization: As appropriate to the implementation

> Precinct/Contest
> Precinct/District/Contest
> Both

• Define the Jurisdiction Title: YourName County
> Set incumbent indicators, if applicable
> Identify write-in label: As appropriate to the implementation
> Identify precinct label: As appropriate to the implementation

• Party Maintenance: Add parties to match ballot type (optional: and import image(s) for the 
header)
> NonPartisan (NP), do not overwrite with anything but nonpartisan-type “party”
> Famous Party (FAM)
> Historical Party (HST)

• Select Languages: As appropriate to implementation
> Select Spanish, if applicable (Training Ballot: English Only)

• Set Ballot Instructions for eSlate and Ballot Now/eScan (optional: and import image)
> Copy and paste from standard instructions language .txt document in Notepad
> Define instructions for audio

• Define eSlate Options
> Close and Suspend Polls times: As appropriate to the implementation
> Minutes Access Codes are active: 30
> Early Voting Retrievable Status: As appropriate to the implementation
> Summary and Verification Pages font size: 14-32 point (to fit candidate names)
> JBC Reports: Tally and/or Write-in and combine splits as appropriate to the implementation
> Include Provisionals in (JBC) Results: As appropriate to the implementation
> VBO Required, VBO Ballot Rejection Limit and VBO Print Ballot Key: As appropriate to the 

implementation
> Passwords for the eSlate

__Administration Password: 222222
__Start-up: 121212
__ED Open Polls:121212
__ED Close Polls:121212
__EV Open Polls:121212
__EV Suspend Polls:121212
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• Define eScan Options
> Close and Suspend Polls times: As appropriate to the implementation
> Passwords for the eScan

__Administration: 222222
__Start-up: 121212
__ED Open Polls: 121212
__ED Close Polls: 121212
__EV Open Polls: 121212
__EV Close Polls: 121212

> eScan Tape: Tally and combine splits as appropriate to the implementation
> Include Provisionals in (eScan) Results: As appropriate to the implementation
> Ballot Processing Settings: As appropriate to the implementation

• Precincts Tab Definitions
> Add 12 precincts, using a two digit naming convention (01 through 12)
> Split precinct 08 into 08A and 08B
> Split precinct 09 into 09A and 09B
> Delete precinct 12
> Consolidate precinct 09
> Move precinct 05 to the top of the list, and then back down

• Districts Tab Definitions, if applicable to the implementation
> Add a “County Wide District” and assign all precincts
> Add “State District 1”, “State District 2”, “State District 3”
> Delete State District 3
> Assign precincts 01-05 to state district 1
> Assign precincts 06-11 to state district 2
> Add a district for County Place 1 and assign precincts 01-03
> Add a district for County Place 2 and assign precincts 04-08, including splits
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•  Contests Tab Definitions (assignments in bold)

  Note:
These are District-to-Contest or Precinct-to-Contest assignments, as applicable.

For each contest or ballot text item, the description field should be modified to identify party 
affiliation if this is a primary election. Contests must be entered per party if this is a primary 
election.

> Add one “Straight Party” contest, if applicable to election type and implementation (County 
Wide District/ or all precincts)

> Add ballot text “Federal Contests” (County Wide District/ or all precincts)
> Add “President” (County Wide District/ or all precincts)
> Add “United States Senator” (County Wide District/ or all precincts)
> Add “United States Representative” (County Wide District/ or all precincts)
> Add ballot text “State Contests” (County Wide District/ or all precincts)
> Add “Proposition 1” (County Wide District/ or all precincts)
> Add “State Senator” (County Wide District/ or all precincts)
> Add “State Representative District 2” (State District 2/ or precincts 06-11)
> Add “State Representative District 1” (State District 1/ or precincts 01-05)
> Add ballot text “County Contests” (County Places 1 and 2/ or precincts 01-08, including 

splits)
> Add “County Commissioner, Place 1” (County Place 1/precincts 01-03)
> Add “County Commissioner, Place 2” (County Place 2/ precincts 04 – 08 including splits)
> Delete “Federal Contests” ballot text item
> Delete “State Contests” ballot text item
> Add ballot text “Ballot Measures” (County Wide District/ or all precincts)
> Update at least one Contest Description field

• Precinct-Level Contests Tab Definitions, if applicable to the implementation (assignments in 
bold)

  Note:
Precincts 08A, 08 B and 11 may be added as a City Place 5 district and assigned in the Contests 
Tab if it is determined that the jurisdiction will not use Precinct-Level Contests.

> Add “Local Contests” (ballot text) (precincts 08A and 08B, 11)
> Add “City Council Member, Place 5” (precincts 08A and 08B, 11)
> Add “City Superintendent of Schools” (precincts 08B, 11)
> Add “Dogcatcher” (precinct 01) - SAVE
> Delete “Dogcatcher” - SAVE

• Polling Places Tab Definitions

  Note:
For primary elections, add polling places as appropriate to the implementation for shared or 
separate polling places per party in a closed primary.

> Add 6 polling places
> Delete one polling place
> Assign precincts to polling places for Early Voting and Election Day, as appropriate to the 

implementation
• Rotation Tab Definitions: As appropriate to the implementation
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Activities in the Active Contests and Contest Details Windows

  Note:
FOR CANDIDATES, ENTER ONE FAMOUS PERSON (e.g., Mel Gibson) AND ONE 
HISTORICAL PERSON (e.g., George Washington) FOR EACH CONTEST.

Enable rotation and fractional cumulative voting as applicable per contest.

If cumulative and/or “vote for” multiple candidates options are used in the implementation, apply 
these settings to county and/or local contests.

Optional: Import images for contests.

• Instruction Note: Change to “Ballot Directions”
• Move “Proposition 1” to the end of the ballot
• Move “Ballot Measures” to precede “Proposition 1”
• Edit Straight Party Contest (straight party, straight party instructions optional) 
• Add Straight Party options:

> Famous Party
> Historical Party

• Edit Contests and Add Options:

  Note:
Apply primary party affiliations and contests shared with nonpartisan for modified closed primary 
as appropriate to the implementation and election.

> President (office, SP, 1 choice, “vote for one” instructions)
> United States Senator (office, SP, 1 choice, “vote for one” instructions)
> United States Representative (office, SP, 1 choice, “vote for one” instructions)
> State Senator (office, SP, 1 choice, “vote for one” instructions)
> State Representative District 2 (office, SP, 1 choice, “vote for one” instructions)
> State Representative District 1 (office, SP, 1 choice, “vote for one” instructions)

• County Contests (ballot text)
> County Commissioner, Place 1 (office, 1 choice, “vote for one” instructions)
> County Commissioner, Place 2 (office, 1 choice, “vote for one” instructions)

• Local Contests (ballot text) 

  Note:
THE FOLLOWING CONTESTS ARE NONPARTISAN (if appropriate for the election type), 
CHOOSE 1 FAMOUS and 1 HISTORICAL PERSON.

> City Council Member, Place 5 (office, 1 choice, 1 write-in, “vote for one” instructions)
> City Superintendent of Schools (office, 1 choice, “vote for one” instructions)

• Ballot Measures (ballot text): Change to standard locally used terminology
> Proposition 1 (proposition, 1 choice, proposition text, instructions, and options in standard 

locally used terminology)

  Note:
If dependent contests are used in the implementation, click the Contests tab and add an office 
contest that will depend on the option chosen in the proposition contest. Move the new contest to 
precede the proposition on the ballot; set up that contest in the Active Contests window, and 
make the proposition dependent on that contest, that option.

• Move “State Representative, District 1” to precede “State Representative, District 2”
• Delete one candidate and add “Bruce Willis” in his/her place
• Move “Bruce Willis” in the candidate order
• Add Candidate Details to “Bruce Willis”. For detail, use delegates, county of residence, or 

profession.
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Completing the Ballot 
• Proofread using the “Active Contests Options List”, “Contest List with Details”, and “Assigned 

Precinct Report” reports
• Record Audio via TRANS

> Record English only. Apply “Auto Proof” functionality. Refer to TRANS agenda and user 
manual.

> Ballot Formats
__Review the Ballot Data Validation tab
__Select Ballot Templates for the eSlate and Ballot Now/eScan, as applicable
__Proofread the ballot on the Ballot Preview tab
__Print from the Ballot Preview tab and consider new formats for ballots that are multi-sheet, 

if possible. Take written note of selected formats.
__MAKE CORRECTIONS, AS NECESSARY, AND FORCE POSITION BREAKS FOR 

UNIQUE LOCATIONS IN ESLATE AND BALLOT NOW BALLOTS
__Export all data elements to a desktop folder named for this election (also: export audio)
__Archive the BOSS database before generating the ballot
__Generate and accept ballot formats (with eCM from M&T course)

• Write Ballot Media
> Write one MBB in Test Mode for upcoming training. At least one station writes six MBBs in 

Election Mode. Write one DAU audio card. Label cards.
• Ballot Reports for Election Support

> Print the “Media Production List” report. Print “Polling Place Summary” reports for both Early 
Voting and Election Day

• Finalize the BOSS database for Tally
> Archive the BOSS database and save to CD before finalizing
> Print the “Audit Trail” report
> Finalize the BOSS database (lock for Tally)
> Archive the finalized BOSS database and save to CD
> Restore either the pre-generated or pre-finalized BOSS database, labeled “RESTORE…”, 

and view
> Delete the restored database

• View/vote ballots on the eSlate, eScan, and/or Ballot Now.

Import/Export Functions
• Create a new BOSS database from imported files (add languages, eSlate Options, eScan 

Options, forced positions)
• Export text and audio strings for foreign language translation, and train in TRANS (follow-up 

available for translators via WebEx sessions)
• Import translated text and audio, and proofread the reports and ballot preview
• Write media (including Demo cards) and view ballots on the eSlate, eScan, and/or Ballot Now.
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Notes:
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Appendix J: BOSS Checklist for Creating a General or Special Election

BOSS Operator Steps (General or Special):

1. Double-click the BOSS desktop shortcut to open the application.

2. Log in to BOSS as a user with all permissions.

3. If you haven’t already done so, set up BOSS users and permission levels.

4. Create a BOSS database named “<Description # Election Type date>”.

5. Open the new BOSS database.

6. Define the general or special election jurisdiction information.

7. Define political parties.

8. Select the languages to appear on ballots.

9. Complete ballot instructions.

10. Define eSlate options.

11. Define eScan options, if applicable.

12. Save Jurisdiction tab data.

13. Define precincts.

14. Define districts and assign precincts, if applicable.

15. Define contests.

16. Define precinct-level contests, if applicable.

17. Define polling places.

18. Select ballot rotation type.

19. Add contest details in the Active Contests window.

20. Edit active contests in the Contest Details window.

21. Proofread the available ballot reports, and make corrections if necessary.

22. As a risk-reduction measure, back up BOSS data and the database.

22.1  Export all BOSS data files.

22.2  Archive the database and save to CD.

23. (Optional) Prepare for ballot translation by proofreading the existing ballots.

24. Create four folders on the PC Desktop for data import and export.

25. Export text for multi-language ballot translation, if applicable. If your ballot is in English only, 
proceed to step 30.

26. Move the contents of the Export Text folder into the Jobs folder.

27. Use TRANS to translate text for multi-language ballots.

28. Move the text files (.xlf) from the Jobs folder to the Import Text folder.
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29. Import translated text for multi-language ballots.

30. Export English text for recording in TRANS.

31. Export audio prompts for multi-language audio recording in TRANS, if applicable.

32. Move the contents of the Export Audio folder into the Jobs folder.

33. Use TRANS to record English and, if applicable, multi-language audio.

34. Move the recorded audio files (.xml and .wav) to the Import Audio folder. 

35. Import recorded audio files.

36. Verify that the ballot is complete. 

37. As a risk-reduction measure, back up BOSS data and the database.

37.1  Export all BOSS data files.

37.2  Export all translated text and recorded audio.

37.3  Archive the database and save to CD.

38. Select templates and preview ballots.

39. Proofread the ballot on the Ballot Preview tab.

40. Generate the ballot, or go back to make corrections.

41. If you haven’t already done so, insert the eCM into a USB port and complete acceptance of 
ballot generation.

42. Print Ballot Style reports.

43. Create the Mobile Ballot Boxes (MBBs) for use in the JBCs, eScan devices, Ballot Now 
PCs, and SERVO, Audio cards for DAU eSlates, and/or Demo cards for eSlate 
Demonstration units.

  See:
  See:“Planning Ballot Media Quantities” on page 24.

44. Print reports.

45. Verify that the MBBs and Audio cards contain the required information in the desired 
format.

46. If necessary, copy the database forward (naming it according to conventions), delete the 
defective version, make corrections in the new database, and repeat necessary steps.

47. As a risk-reduction measure, archive the database and save to CD.

48. Finalize the BOSS database for Tally.

49. As a risk-reduction measure, archive the database and save to CD.

50. Exit BOSS.

BOSS Operator Steps (General or Special):
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Appendix K: BOSS Checklist for Creating a Primary Election

BOSS Operator Steps (Primary):

1. Double-click the BOSS desktop shortcut to open the application.

2. Log in to BOSS as a user with all permissions.

3. If you haven’t already done so, set up BOSS users and permission levels.

4. Create a BOSS database named “<Description # Election Type date>”.

5. Open the new BOSS database.

6. Define the primary election jurisdiction information.

7. Define primary election political parties and primary ballot headers.

8. Select the languages to appear on ballots.

9. Complete ballot instructions.

10. Define eSlate options.

11. Define eScan options, if applicable.

12. Save Jurisdiction tab data.

13. Define precincts.

14. Define districts and assign precincts, if applicable.

15. Define closed primary election contests.

16. OR Define modified closed primary election contests.

17. Define precinct-level contests, if applicable.

18. Define closed primary election polling places.

19. OR Define modified closed primary election polling places.

20. Select ballot rotation type.

21. Add primary election contest details in the Active Contests window.

22. Edit primary election active contests in the Contest Details window.

23. Proofread the available ballot reports, and make corrections if necessary.

24. As a risk-reduction measure, back up BOSS data and the database.

24.1  Export all BOSS data files.

24.2  Archive the database and save to CD.

25. (Optional) Prepare for ballot translation by proofreading the existing ballots.

26. Create four folders on the PC Desktop for data import and export.

27. Export text for multi-language ballot translation, if applicable. If your ballot is in English only, 
proceed to step 32.

28. Move the contents of the Export Text folder into the Jobs folder.
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29. Use TRANS to translate text for multi-language ballots.

30. Move the text files (.xlf) from the Jobs folder to the Import Text folder.

31. Import translated text for multi-language ballots.

32. Export English text for recording in TRANS.

33. Export audio prompts for multi-language audio recording in TRANS, if applicable.

34. Move the contents of the Export Audio folder into the Jobs folder.

35. Use TRANS to record English and, if applicable, multi-language audio.

36. Move the recorded audio files (.xml and .wav) to the Import Audio folder. 

37. Import recorded audio files.

38. Verify that the ballot is complete.

39. As a risk-reduction measure, back up BOSS data and the database.

39.1  Export all BOSS data files.

39.2  Export all translated text and recorded audio.

39.3  Archive the database and save to CD.

40. Select templates and preview ballots.

41. Proofread the ballot on the Ballot Preview tab.

42. Generate the ballot, or go back to make corrections.

43. If you haven’t already done so, insert the eCM into a USB port and complete acceptance of 
ballot generation.

44. Print Ballot Style reports.

45. Create the Mobile Ballot Boxes (MBBs) for use in the JBCs, eScan devices, Ballot Now 
PCs, and SERVO, Audio cards for DAU eSlates, and/or Demo cards for eSlate 
Demonstration units.

  See:
  See:“Planning Ballot Media Quantities” on page 24.

46. Print reports.

47. Verify that the MBBs and Audio cards contain the required information in the desired 
format.

48. If necessary, copy the database forward (naming it according to conventions), delete the 
defective version, make corrections in the new database, and repeat necessary steps.

49. As a risk-reduction measure, archive the database and save to CD.

50. Finalize the BOSS database for Tally.

51. As a risk-reduction measure, archive the database and save to CD.

52. Exit BOSS.

BOSS Operator Steps (Primary):
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Appendix L: BOSS Checklist for Using Imported Data to Create an Election

BOSS Operator Steps (Importing Data):

1. Double-click the BOSS desktop shortcut to open the application.

2. Log in to BOSS as a user with all permissions.

3. If you haven’t already done so, set up BOSS users and permission levels.

4. Create a BOSS database named “<Description # Election Type date>”.

5. Open the new BOSS database.

6. Create or obtain import files and copy to C:\Boss\Import.

7. Go to the Election menu, click Import/Export, and then click the Import tab.

8. Begin importing ballot data.

9. Respond to prompts confirming import processes.

10. When importing the Party.txt file the Records Already Exist for the Data Element dialog 
window appears. 

11. Confirm import of the Precinct.txt data

12. Proceed to update the registered voter data with the Party_Voters.txt import.

13. When BOSS encounters large import files, the BOSS FastLoad! dialog window appears.

14. IF invalid records are encountered, a dialog window informing the user of the error appears 
first. 

15. IF BOSS encounters invalid records, continue as if repairing the file.

16. IF BOSS encounters invalid records, the Invalid Record List displays.

17. IF correcting the source file, open the source file and correct the error.

18. IF correcting the source file, select (ALL) and update existing data.

19. Confirm import of corrected data.

20. Complete ballot data imports.

21. Select languages for the ballot, if applicable.

22. Complete ballot instructions, if necessary.

23. Define eSlate options.

24. Define eScan options, if applicable.

25. Select contest position force settings.

26. Proofread the available ballot reports, and make corrections if necessary.

27. (Optional) Prepare for ballot translation by proofreading the existing ballots.

28. Create four folders on the PC Desktop for data import and export.

29. Export text for multi-language ballot translation, if applicable. If your ballot is in English only, 
proceed to step 34.
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30. Move the contents of the Export Text folder into the Jobs folder.

31. Use TRANS to translate text for multi-language ballots.

32. Move the text files (.xlf) from the Jobs folder to the Import Text folder.

33. Import translated text for multi-language ballots.

34. Export English text for recording in TRANS.

35. Export audio prompts for multi-language audio recording in TRANS, if applicable.

36. Move the contents of the Export Audio folder into the Jobs folder.

37. Use TRANS to record English and, if applicable, multi-language audio.

38. Move the recorded audio files (.xml and .wav) to the Import Audio folder. 

39. Import recorded audio files.

40. Verify that the ballot is complete.

41. As a risk-reduction measure, back up BOSS data and the database.

41.1  Export all BOSS data files.

41.2  Export all translated text and recorded audio.

41.3  Archive the database and save to CD.

42. Select templates and preview ballots.

43. Proofread the ballot on the Ballot Preview tab.

44. Generate the ballot, or go back to make corrections.

45. If you haven’t already done so, insert the eCM into a USB port and complete acceptance of 
ballot generation.

46. Print Ballot Style reports.

47. Create the Mobile Ballot Boxes (MBBs) for use in the JBCs, eScan devices, Ballot Now 
PCs, and SERVO, Audio cards for DAU eSlates, and/or Demo cards for eSlate 
Demonstration units.

  See:
  See:“Planning Ballot Media Quantities” on page 24.

48. Print reports.

49. Verify that the MBBs and Audio cards contain the required information in the desired format.

50. If necessary, copy the database forward (naming it according to conventions), delete the 
defective version, make corrections in the new database, and repeat necessary steps.

51. As a risk-reduction measure, archive the database and save to CD.

52. Finalize the BOSS database for Tally.

53. As a risk-reduction measure, archive the database and save to CD.

54. Exit BOSS.

BOSS Operator Steps (Importing Data):
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